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Introduzione

Avviso importante

 Il contenuto di questo documento e le specifiche di questo prodotto sono soggetti a modifiche senza 
preavviso.

 Brother si riserva il diritto di apportare modifiche senza preavviso alle specifiche e ai materiali qui contenuti 
e non potrà essere in alcun modo ritenuta responsabile di eventuali danni (inclusi quelli indiretti) causati 
dall'affidamento riposto nei materiali presentati, inclusi, a titolo esemplificativo ma non esaustivo, gli errori 
tipografici e di altro tipo eventualmente contenuti nelle pubblicazioni.

 Le immagini delle schermate riportate in questo documento possono differire a seconda del sistema 
operativo del computer, del modello del prodotto e della versione del software.

 Prima di utilizzare la stampante di etichette, accertarsi di leggere tutta la documentazione fornita con 
la stessa, per informazioni sulla sicurezza e sull'utilizzo corretto.

 La stampante mostrata nelle illustrazioni potrebbe essere diversa dalla stampante in uso.

 Le forniture disponibili possono variare a seconda del paese.

Manuali disponibili

Per scaricare le più recenti versioni dei manuali, visitare il Brother Solutions Center all'indirizzo 
support.brother.com e fare clic su Manuali.

1 Manuale stampato nella confezione.
2 Manuale PDF sul sito Web Brother Solutions Center.

Guida di sicurezza prodotto 1 Questa guida fornisce informazioni sulla sicurezza; è necessario 
leggerla prima di utilizzare la stampante.

Guida di installazione rapida 1 Questa guida fornisce le informazioni di base sull'uso della 
stampante, nonché suggerimenti sulla risoluzione dei problemi.

Guida dell'utente 2 Questa guida fornisce ulteriori informazioni sulle impostazioni 
e le operazioni della stampante, suggerimenti sulla soluzione dei 
problemi e istruzioni per la manutenzione.

http://support.brother.com/
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Simboli usati in questa guida

Nella presente guida sono utilizzati i seguenti simboli:

Indica una situazione potenzialmente pericolosa che, se il prodotto viene utilizzato 
senza attenersi alle avvertenze e alle istruzioni, potrebbe provocare la morte 
o gravi lesioni.

Indica una situazione potenzialmente pericolosa che, se non viene evitata, 
potrebbe provocare lesioni di piccola o moderata entità.

IMPORTANTE Indica informazioni o istruzioni da seguire. Il mancato rispetto di tali istruzioni può 
causare danni o malfunzionamenti.

Nota Indica informazioni o istruzioni utili per comprendere e utilizzare il prodotto in modo 
più efficiente.

AVVERTENZA

ATTENZIONE
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Precauzioni generali
Rotolo DK (etichetta DK e nastro DK)

 Usare solo accessori e materiali di consumo originali Brother (con i simboli  e ). NON utilizzare 
accessori o materiali di consumo non autorizzati.

 Se l'etichetta viene applicata a una superficie bagnata, sporca o oleosa, potrebbe staccarsi facilmente. 
Prima di applicare l'etichetta, pulire la superficie sulla quale essa verrà attaccata.

 I rotoli DK utilizzano carta o pellicola termica che può scolorirsi o attaccarsi alle superfici, se esposta 
a luce ultravioletta, vento o pioggia.

 Non esporre i rotoli DK alla luce solare diretta, a temperature o umidità elevate o a polvere. Riporlo in un 
luogo fresco e buio. Utilizzare i rotoli DK subito dopo aver aperto la confezione che li contiene.

 Se si graffia con le dita od oggetti metallici la superficie stampata dell'etichetta, oppure se la si tocca con 
le mani umide o bagnate, il colore potrebbe cambiare o sbiadirsi.

 Non applicare etichette su persone, animali o piante. Inoltre, non applicare mai etichette in luoghi 
pubblici o privati, senza l'apposita autorizzazione.

 Poiché la fine del rotolo DK è studiata in modo tale da non aderire alla bobina di etichette, è possibile 
che l'ultima etichetta non venga tagliata correttamente. In tal caso, rimuovere le etichette rimanenti, 
inserire un nuovo rotolo DK e ristampare l'ultima etichetta.

Nota: considerando quanto sopra, il numero di etichette DK incluso in ciascun rotolo DK potrebbe essere 
superiore a quello indicato sulla confezione.

 Quando un'etichetta viene rimossa dopo essere stata applicata a una superficie, è possibile che una 
parte di essa resti attaccata.

 Prima di utilizzare etichette per CD/DVD, assicurarsi di seguire le istruzioni riportate nel manuale 
di istruzioni del lettore CD/DVD in merito all'applicazione di etichette CD/DVD.

 NON utilizzare etichette per i lettori CD/DVD con caricamento a fessura.

 NON rimuovere l'etichetta del CD/DVD dopo averla applicata sul CD/DVD, in quanto potrebbe staccarsi 
un piccolo strato superficiale, con conseguente danneggiamento del disco.

 NON applicare etichette CD/DVD ai dischi CD/DVD progettati per l'uso con stampanti a getto 
d'inchiostro. Le etichette si staccano facilmente da questo tipo di dischi e l'utilizzo di dischi con etichette 
staccate può provocare la perdita o il danneggiamento dei dati.

 Per applicare etichette per CD/DVD, utilizzare l'apposito applicatore incluso con le bobine di etichette 
CD/DVD. La mancata adozione di questo accorgimento potrebbe comportare il danneggiamento 
del lettore CD/DVD.

 Gli utenti saranno pienamente responsabili dell'applicazione delle etichette per CD/DVD. Brother non 
accetta alcuna responsabilità per la perdita o il danneggiamento dei dati provocato dall'uso improprio 
di etichette per CD/DVD.

 Fare attenzione a non lasciar cadere il rotolo DK.

 I rotoli DK utilizzano carta e pellicola termica. Sia le etichette che le stampe sbiadiscono in presenza 
di luce solare e calore.
Se si desidera preservare la durata, NON usare rotoli DK all'aperto.
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 A seconda dell'area, del materiale e delle condizioni ambientali, l'etichetta può non staccarsi o diventare 
irremovibile, il colore dell'etichetta può cambiare o essere trasferito su altri oggetti. Prima di applicare 
l'etichetta, controllare le condizioni ambientali e il materiale. Provare l'etichetta applicandone una piccola 
parte a un'area non appariscente della superficie desiderata.

 Se i risultati della stampa non rispondono alle aspettative, utilizzare le opzioni di regolazione nel driver 
stampante o nello Strumento di impostazione della stampante.

Precauzioni generali
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Descrizione dei componenti 1

Lato anteriore 1

Configurazione della stampante 
di etichette 1

1 LED di stato

2 Pulsante di alimentazione

3 Pulsante di avanzamento carta

4 Pulsante taglierina

5 Pulsante Editor Lite

6 LED Editor Lite

7 Coperchio del vano del rotolo DK

8 Fessura di uscita delle etichette
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1
Lato posteriore 1

1 Porta USB

2 Porta host USB

3 Porta di alimentazione CA

1

3
2
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1
Collegamento del cavo di alimentazione 1

Collegare il cavo di alimentazione CA alla stampante. Quindi, inserire il cavo di alimentazione CA in una 
presa elettrica dotata di messa a terra.

IMPORTANTE

Non usare la stampante in aree in cui le tensioni di alimentazione sono diverse da quella specifica della 
stampante. Per dettagli sulla tensione corrispondente, vedere Specifiche del prodotto a pagina 119.
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1
Caricamento del rotolo DK 1

a Accertarsi che la stampante sia spenta.

b Tirare la leva di rilascio su entrambi i lati della stampante per sbloccare il coperchio del vano del rotolo DK. 
Afferrare la stampante dal lato anteriore e sollevare con decisione il coperchio del vano del rotolo DK 
per aprirlo.

IMPORTANTE

Prima di utilizzare la stampante, rimuovere la pellicola protettiva (1) dalla fessura di uscita delle etichette.

1
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1
c Posizionare il rotolo DK nella guida della bobina portarotolo (1).

• Assicurarsi che il braccio della bobina portarotolo (2) sia inserito saldamente nella guida della bobina 
portarotolo.

• Accertarsi che lo stabilizzatore (3) scorra nella fessura della stampante.

d Far scorrere il rotolo DK attraverso la stampante.
• Allineare il bordo del rotolo DK con il bordo verticale della fessura di uscita delle etichette.
• Controllare che il rotolo DK sia filettato in modo dritto così da evitare etichette storte.

• Far passare la prima etichetta attraverso la fessura di uscita delle etichette fino a che l'estremità non 
fuoriesce dalla fessura, come mostrato.

Nota
In caso di problemi con l'inserimento della prima etichetta, provare a inserirla dalla parte sotto il sensore (1).

1

3
2

1
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1
e Chiudere il coperchio del vano del rotolo DK.

IMPORTANTE

• Non lasciare le etichette stampate nella stampante. Così facendo, le etichette potrebbero incepparsi.

• Quando non in uso, rimuovere i rotoli DK dall'interno della stampante e chiudere il coperchio del vano del 
rotolo DK per prevenire la formazione di polvere e detriti nella stampante.
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1
Accensione/spegnimento 1

Accensione: premere il pulsante di alimentazione ( ) per accendere la stampante. Il LED di stato diventa 
verde.

IMPORTANTE

Premere il pulsante di avanzamento carta ( ) per allineare l'estremità del rotolo DK.

Spegnimento: premere e tenere premuto nuovamente il pulsante di alimentazione ( ) per spegnere 
la stampante.

IMPORTANTE

Quando si spegne la stampante, non scollegare il cavo di alimentazione CA se non dopo l'avvenuto 
spegnimento del LED di stato.
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2

2
Installare i driver e il software della stampante su un computer2

Per stampare da un computer Windows o da un Mac, è necessario installare il driver della stampante, 
P-touch Editor e altre applicazioni nel computer.

Software per Windows: 
Driver della stampante, P-touch Editor, P-touch Address Book, P-touch Update Software e Strumento 
di impostazione della stampante

Software per Mac: 
Driver della stampante, P-touch Editor, P-touch Update Software e Printer Setting Tool (Strumento 
di impostazione della stampante)

IMPORTANTE

Quando si stampa con P-touch Editor, premere e tenere premuto il pulsante P-touch Editor Lite fino 
a quando l'indicatore LED verde di Editor Lite si spegne.

a Visitare il nostro sito Web (install.brother) e scaricare il programma di installazione del software e dei 
manuali più aggiornati.

b Fare doppio clic sul file scaricato EXE (per Windows) o DMG (per Mac) e seguire le istruzioni a schermo 
per procedere con l'installazione.

c Al termine dell'installazione, chiudere la finestra di dialogo.

Collegamento della Stampante di etichette a un computer 2

È possibile collegare la stampante a un computer Windows o a un Mac usando un cavo USB.

a Prima di collegare il cavo USB, assicurarsi che la stampante sia spenta.

b Collegare il cavo USB alla porta USB sul retro della stampante, quindi al computer in uso.

c Accendere la stampante.

Stampa da un computer (P-touch Editor) 2

http://install.brother
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2

Stampa da un computer 2

Applicazioni disponibili 2

Per usare la stampante in modo efficace, è disponibile una serie di applicazioni e funzioni.

Per usare le applicazioni è necessario installare il driver della stampante.

Visitare il sito Web Brother (install.brother) e scaricare il programma di installazione delle applicazioni 
e il driver della stampante. 

Applicazione Windows Mac Funzioni

P-touch Editor r r
Consente di progettare e stampare etichette personalizzate 
con strumenti di disegno incorporati, scrivere usando font 
e stili diversi, immagini grafiche importate e codici a barre.

P-touch Transfer Manager r

Consente di trasferire modelli e altri dati alla stampante 
e di salvare backup dei dati nel computer.

Viene installata con P-touch Editor.

P-touch Library r

Consente di gestire e stampare modelli P-touch Editor.

Per stampare i modelli, è possibile utilizzare P-touch Library.

Viene installata con P-touch Editor.

P-touch Update Software r r Consente di aggiornare il software alla versione più recente.

P-touch Address Book r
Consente di stampare le etichette dell'indirizzo usando 
un database indirizzi.

Strumento 
di impostazione 
della stampante 
(Printer Setting Tool)

r r
Consente di specificare le impostazioni della stampante 
da un computer.

Funzione Windows Mac Funzioni

Ritaglio stampa r

Questa stampante è in grado di stampare uno o più codici 
a barre da un file .pdf di grandezza A4/Letter. Individua 
automaticamente i codici a barre, che poi ritaglia e stampa 
singolarmente.

Stampa distribuita r

Quando si stampa un numero elevato di etichette, la stampa 
può essere distribuita tra più stampanti.

Poiché la stampa viene eseguita contemporaneamente, 
è possibile ridurre il tempo di stampa totale.

Per ulteriori informazioni, vedere Stampa distribuita (solo 
Windows) a pagina 56.

http://install.brother
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2

Creazione di etichette dal computer 2

Questa stampante consente di stampare in vari modi.

Di seguito viene descritta la procedura di stampa da un computer usando P-touch Editor o P-touch Address Book.

a Avviare P-touch Editor o P-touch Address Book, quindi aprire il documento da stampare.

b Creare un progetto di etichetta.

c Controllare le opzioni di taglio.

d Selezionare File > Stampa o fare doppio clic sull'icona Stampa.

Opzioni di taglio 2

Le opzioni di taglio consentono di specificare in che modo viene fatto avanzare l'elemento e come viene 
tagliato durante la stampa. Usare il driver della stampante per selezionare l'opzione di taglio quando si stampa 
dal computer.

Tabella delle opzioni di taglio delle etichette

Taglio automatico Taglia alla fine Immagine

No Sì

No No

Sì Sì o No

ABCABC

ABCABC

ABC
ABC
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2

Applicazione di etichette 2

a Rimuovere il supporto dall'etichetta.

b Posizionare l'etichetta, quindi premere con decisione con un dito, dall'alto verso il basso, per applicare 
l'etichetta.

Nota
Le etichette si applicano con difficoltà alle superfici bagnate, sporche o non uniformi e potrebbero staccarsi 
facilmente da tali superfici.
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3

P-touch Editor Lite 3

P-touch Editor Lite è un'applicazione software per la creazione di etichette per computer. Con P-touch Editor 
Lite, non è necessario installare alcuna applicazione o driver stampante. È sufficiente collegare un cavo USB 
alla stampante di etichette.

Questa applicazione consente di creare e stampare etichette semplici con testo, riquadri e immagini.

a Accendere la stampante, quindi premere e tenere premuto il pulsante P-touch Editor Lite fino a quando 
si accende il LED verde di P-touch Editor Lite.

1 LED Editor Lite

2 Pulsante Editor Lite

Nota
In modalità predefinita, P-touch Editor Lite è impostato su Spento.

b Collegare il cavo USB al computer.

Nota
Se si collega la stampante tramite un cavo USB, è possibile che esso non venga rilevato correttamente. 
In questo caso, scollegare il cavo USB, controllare che la stampante sia accesa e ricollegare il cavo USB.

Stampa utilizzando P-touch Editor Lite 
(solo Windows) 3

12
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3

c Dopo avere collegato il cavo USB, sul monitor del computer viene visualizzata una finestra di dialogo. 
(Le seguenti schermate potrebbero variare a seconda del sistema operativo installato nel computer, 
anche se le procedure operative sono uguali.)

Nota
• Se la finestra di dialogo non è visibile, potrebbe essere nascosta dietro la finestra di un programma aperto. 

Per visualizzare la finestra di dialogo, ridurre a icona tutte le finestre.

• La prima volta che si collega la stampante al computer, l'avvio di P-touch Editor Lite potrebbe richiedere più 
tempo del solito. Se il software non si avvia automaticamente quando si collega la stampante, è possibile 
avviarlo da Risorse del computer. Avviare P-touch Editor Lite facendo doppio clic su PTLITE10.EXE.

Fare clic su Apri cartella per visualizzare i file.

Fare doppio clic su PtLite10.
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d P-touch Editor Lite viene avviato.

IMPORTANTE

Mentre si utilizza P-touch Editor Lite, non spegnere e non scollegare la stampante.

Nota
P-touch Editor Lite non è disponibile per Mac.
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4

Installazione di applicazioni utilizzabili con dispositivi mobili 4

È possibile utilizzare la stampante di etichette come macchina autonoma o collegarla a un dispositivo mobile. 
Per creare e stampare etichette direttamente dal dispositivo mobile, installare le applicazioni mobili Brother, 

quindi collegare la stampante al dispositivo mobile tramite un cavo USB On-The-Go 1.
1 Venduto separatamente

Applicazioni disponibili 4

Scaricare queste applicazioni Brother gratuitamente da Google Play:

Stampa mediante un dispositivo mobile 4

Applicazione Funzioni

Brother iPrint&Label
Questa applicazione consente di creare e stampare etichette da modelli, 
utilizzando un dispositivo mobile.

Mobile Transfer Express
L'applicazione permette di utilizzare un dispositivo mobile per scaricare 
database e dati di etichette, creati su un computer con P-touch Editor 
e salvati su un servizio cloud, e di inviarli alla stampante.
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Stampa di etichette da un dispositivo mobile 4

a Avviare l'applicazione di stampa mobile sul dispositivo mobile.

Nota
Controllare che la stampante sia collegata al dispositivo mobile in uso mediante un cavo USB On-The-Go.

b Selezionare un modello o un progetto di etichetta.

Nota
È anche possibile selezionare un'etichetta o un'immagine elaborata in precedenza e stamparla.

c Toccare Stampa nel menu dell'applicazione.

Opzioni di taglio 4

Vedere Opzioni di taglio a pagina 11.

Uso di un dispositivo mobile per stampare modelli creati su un computer 4

Con P-touch Transfer Manager è possibile salvare in formato .pdz i dati del modello creati mediante 
P-touch Editor. È possibile usare Mobile Transfer Express per inviare il file salvato dal dispositivo mobile alla 
stampante e poi stamparlo.

a Salvare i dati del modello in formato .pdz usando P-touch Transfer Manager.
Per ulteriori informazioni, vedere Creazione di file pacchetto per trasferimento a pagina 85.

b Per usare un file .pdz con il dispositivo mobile, utilizzare uno dei seguenti metodi.

 Salvare il file usando un servizio di archiviazione cloud e sfruttare la funzione di condivisione del sistema 
operativo del dispositivo mobile per condividere il file.

 Inviare il file come allegato e-mail dal computer al dispositivo mobile, quindi salvare il file sul dispositivo 
mobile.

c Collegare la stampante al dispositivo mobile e avviare Mobile Transfer Express.
Vengono visualizzati i dati del modello.

d Selezionare il modello da stampare, quindi trasferire il modello alla stampante.

Nota
Per scaricare un file da un servizio di archiviazione cloud al dispositivo mobile, è necessario collegare 
il dispositivo mobile con la modalità Infrastruttura.

e Utilizzare lo scanner di codici a barre per selezionare il modello che si intende stampare dal file trasferito 
e stamparlo.
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Applicazione di etichette 4

a Rimuovere il supporto dall'etichetta.

b Posizionare l'etichetta, quindi premere con decisione con un dito, dall'alto verso il basso, per applicare 
l'etichetta.

Nota
Le etichette si applicano con difficoltà alle superfici bagnate, sporche o non uniformi e potrebbero staccarsi 
facilmente da tali superfici.
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Strumento di impostazione della stampante per Windows 5

Lo Strumento di impostazione della stampante consente di specificare le impostazioni di comunicazione della 
stampante, le impostazioni dei dispositivi e le impostazioni di P-touch Template da un computer Windows.

Nota
Lo Strumento di impostazione della stampante viene installato automaticamente quando viene avviato 
il programma di installazione del driver della stampante. Per ulteriori informazioni, vedere Installare i driver 
e il software della stampante su un computer a pagina 9.

IMPORTANTE

Lo Strumento di impostazione della stampante è disponibile solo per stampanti Brother compatibili.

Prima di usare lo Strumento di impostazione della stampante 5

 Accertarsi che il cavo di alimentazione CA sia collegato alla stampante e a una presa elettrica.

 Assicurarsi che il driver della stampante sia stato installato correttamente e che la stampa sia abilitata.

 Collegare la stampante a un computer tramite un cavo USB.

Modifica delle impostazioni della 
stampante di etichette 5
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Uso dello Strumento di impostazione della stampante 
per Windows 5

a Collegare al computer la stampante da configurare.

b Avviare lo Strumento di impostazione della stampante.

 Per Windows 7:

Fare clic su Start > Tutti i programmi > Brother > Label & Mobile Printer > Printer Setting Tool 
(Strumento di impostazione della stampante).

 Per Windows 8 / Windows 8.1:

Nella schermata App, fare clic su Printer Setting Tool (Strumento di impostazione della stampante). 

 Per Windows 10:

Fare clic su Start > Brother > Printer Setting Tool (Strumento di impostazione della stampante). 

Viene visualizzata la finestra principale.

1 Stampante
Elenca le stampanti collegate.

2 Impostazioni dispositivo
Specifica le impostazioni del dispositivo. Ad esempio, le impostazioni dell'alimentazione.

3 Impostazioni P-touch Template
Specifica le impostazioni di P-touch Template.
Per ulteriori informazioni su P-touch Template, scaricare il documento "P-touch Template 
Manual/Command Reference" (Manuale per P-touch Template/Riferimento per i comandi) (solo in 
inglese) dal sito Brother Solutions Center all'indirizzo support.brother.com/manuals 

4 Esci
Chiude la finestra.

1

2

3

4

http://support.brother.com/manuals
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c Controllare che la stampante da configurare sia presente accanto a Stampante. Se viene visualizzata 
una stampante diversa, selezionare la stampante desiderata dall'elenco a discesa.

d Consente di selezionare le impostazioni da modificare e specificare o modificare le impostazioni nella 
finestra di dialogo.
Per ulteriori informazioni sulle finestre di dialogo delle impostazioni, vedere Impostazioni dispositivo per 
Windows a pagina 22 o Impostazioni di P-touch Template per Windows a pagina 27.

e Fare clic su Applica per applicare le impostazioni alla stampante.

f Per completare la modifica delle impostazioni nella finestra principale, fare clic su Esci.

IMPORTANTE

Lo Strumento di impostazione della stampante deve essere utilizzato per configurare la stampante solo 
quando questa è in fase di standby. Se si tenta di eseguire la configurazione mentre è in corso la stampa 
di un lavoro, la stampante potrebbe non funzionare correttamente.
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Impostazioni dispositivo per Windows 5

Usare Impostazioni dispositivo in Strumento di impostazione della stampante per specificare o modificare 
le impostazioni della stampante quando si collegano la stampante e il computer con un cavo USB. È possibile 
non solo modificare le impostazioni dispositivo per una stampante, ma anche applicare facilmente le stesse 
impostazioni a più stampanti.

Quando si stampa da un'applicazione per computer, è possibile specificare diverse impostazioni di stampa dal 
driver stampante; tuttavia, se si utilizza l'opzione Impostazioni dispositivo dello Strumento di impostazione 
della stampante, è possibile specificare altre impostazioni avanzate.

Quando si apre Impostazioni dispositivo, vengono recuperate e visualizzate le impostazioni correnti della 
stampante. Se non è stato possibile recuperare le impostazioni correnti, vengono visualizzate le impostazioni 
precedenti. Se non è stato possibile recuperare le impostazioni correnti e le impostazioni precedenti non 
sono state specificate, vengono visualizzate le impostazioni predefinite della macchina.

Finestra di dialogo delle impostazioni 5

1 Barra dei menu
I comandi sono suddivisi in categorie in ogni menu (File, Manutenzione e Informazioni su...) in base alla 
loro funzione.

2 Stamp
Specifica la stampante da configurare.

1
2
3
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3 Schede delle impostazioni
Contengono impostazioni che possono essere specificate o modificate.

Nota

Se nella scheda è presente l'icona , le impostazioni contenute in tale scheda non possono essere 

modificate. Inoltre, le impostazioni della scheda non saranno applicate alla stampante anche se si fa clic 
su Applica. Inoltre, quando si utilizzano i comandi Salva nel file di comando o Esporta, le impostazioni 
specificate nella scheda non verranno salvate né esportate.

4 Impostazioni correnti
Recupera le impostazioni dalla stampante collegata correntemente e le visualizza nella finestra di dialogo. 

Le impostazioni saranno recuperate anche per i parametri sulle schede che presentano l'icona .

5 Disattiva queste impostazioni

Se si seleziona questa casella di controllo, nella scheda compare l'icona  e le impostazioni non 

possono essere più né specificate né modificate.

Le impostazioni di una scheda in cui è presente l'icona  non saranno applicate alla stampante, 

neanche facendo clic su Applica. Inoltre, quando si utilizzano i comandi Salva nel file di comando 
o Esporta, le impostazioni specificate nella scheda non verranno salvate né esportate.

6 Parametri
Visualizza le impostazioni correnti.

7 Esci
Consente di uscire da Impostazioni dispositivo e di tornare alla finestra principale di Strumento 
di impostazione della stampante.

8 Applica
Applica le impostazioni alla stampante.
Per salvare le impostazioni specificate in un file di comando, selezionare Salva nel file di comando 
nell'elenco a discesa.
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Barra dei menu 5

Opzioni di menu File

• Applica impostazione alla stampante...

Applica le impostazioni alla stampante.

• Verifica impostazione

Visualizza le impostazioni correnti.

• Salva impostazioni nel file di comando

Salva le impostazioni specificate in un file di comando.

• Importa

Importa il file esportato.

• Esporta

Salva in un file le impostazioni correnti.

Opzioni di menu Manutenzione

• Impostazioni unità di stampa...

Stampa un rapporto che contiene la versione del firmware corrente e informazioni sulle impostazioni del 
dispositivo.
Questo rapporto può essere stampato anche mediante il pulsante taglierina ( ). Per ulteriori informazioni, 
vedere Conferma delle impostazioni della stampante di etichette a pagina 50.

Nota
Per stampare il rapporto, è consigliabile usare un rotolo DK da 62 mm o più grande.

• Ripristina predefiniti...

Consente di ripristinare tutte le impostazioni ai valori di fabbrica, incluse le impostazioni del dispositivo 
e i dati trasferiti.

• Impostazioni ripristino del solo dispositivo

Ripristina le impostazioni di fabbrica del dispositivo nella scheda Base, Avanzato e Gestione.

• Elimina modello e database

Elimina i modelli e i database memorizzati nella stampante.

• Impostazioni opzioni

Se la casella di controllo Non visualizzare un messaggio di errore se le impostazioni correnti 
non possono essere recuperate all'avvio è selezionata, la volta successiva non verrà visualizzato 
un messaggio.
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Scheda Base 5

• Accensione automatica

Specifica se la stampante si accende automaticamente quando il cavo di alimentazione CA viene collegato 
a una presa elettrica.

• Spegnimento automatico

Specifica quanto tempo trascorre prima che la stampante si spenga automaticamente quando è collegata 
a una presa elettrica.

Scheda Avanzate 5

• Stampa dati dopo aver stampato

Specifica se i dati di stampa vengono cancellati dopo la stampa.

• Stampa rapporto informazioni

Consente di selezionare le informazioni da includere nel Stampa rapporto informazioni.

• Taglio Autom.

Imposta il metodo di taglio quando si stampano più etichette.

• Mod. serial.

Specifica la modalità di serializzazione desiderata (numero) delle etichette stampate.

Scheda di gestione 5

IMPORTANTE

Per visualizzare questa scheda, è necessario disporre dei privilegi di amministratore per il computer 
o la stampante.
È possibile confermare i privilegi di amministratore per la stampante nella scheda Proprietà stampante > 
Sicurezza.

• Modalità di comando

Consente di selezionare il tipo di modalità comando.
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Applicazione delle modifiche delle impostazioni a più stampanti di etichette 5

a Dopo aver applicato le impostazioni alla prima stampante, scollegare la stampante dal computer 
e collegare la seconda stampante al computer.

b Selezionare la stampante collegata di recente dall'elenco a discesa Stamp.

c Fare clic su Applica. Le stesse impostazioni che erano state applicate alla prima stampante vengono 
applicate alla seconda.

d Ripetere i passaggi da a a c per tutte le stampanti di cui si desidera modificare le impostazioni.

Nota
Per salvare le impostazioni correnti in un file, fare clic su File > Esporta.

È possibile applicare le stesse impostazioni a un'altra stampante facendo clic su File > Importa 
e selezionando quindi il file delle impostazioni esportate. Per ulteriori informazioni, vedere Impostazioni 
dispositivo per Windows a pagina 22.
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Impostazioni di P-touch Template per Windows 5

La modalità P-touch Template consente di inserire dati di oggetti testo e codice a barre da un modello 
scaricato mediante altri dispositivi collegati alla stampante.

Le opzioni e le forniture disponibili possono variare a seconda del paese.

Per specificare o modificare le funzioni di P-touch Template, aprire lo Strumento di impostazione della 
stampante e selezionare Impostazioni P-touch Template.

Nota
• La modalità P-touch Template è compatibile anche con altri dispositivi di ingresso quali bilance, macchine 

per test, controller o dispositivi a logica programmabile.

• Per ulteriori informazioni sulle impostazioni di P-touch Template, scaricare il documento "P-touch Template 
Manual/Command Reference" (Manuale per P-touch Template/Riferimento per i comandi) (solo in 
inglese) dal sito Brother Solutions Center all'indirizzo support.brother.com/manuals 

http://support.brother.com/manuals
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Finestra di dialogo Impostazioni P-touch Template 5

1 Default Command Mode (Modalità di comando predefinita)
Imposta la modalità P-touch Template come modalità predefinita.
Per cambiare la modalità, vedere la Scheda di gestione a pagina 25.

2 Default Template Number (Numero di modello predefinito)
Specifica un numero di modello predefinito impostato dalla stampante quando viene accesa. Tuttavia, 
se non si trasferisce alcun modello alla stampante, non specificare un numero di modello.

3 Data Delimiter for P-touch Template (Delimitatore di dati per modello P-touch)
Visualizza un simbolo utilizzato per indicare i limiti tra gruppi di dati in un file (massimo 20 caratteri).

4 Trigger for P-touch Template Printing (Trigger per la stampa del modello P-touch)
Consente di specificare un trigger per l'avvio della stampa da una serie di opzioni.

• Command Character (Carattere di comando): la stampa ha inizio quando viene ricevuto il carattere 
di comando specificato qui.

• Data Insertion into All the Objects (Inserimento dati in tutti gli oggetti): la stampa ha inizio quando 
viene ricevuto il delimitatore per l'ultimo oggetto.

• Received Data Size (Dimensioni dei dati ricevuti): la stampa ha inizio quando viene ricevuto il numero 
di caratteri specificato qui. Tuttavia, i delimitatori non vengono contati nel numero di caratteri.

1
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5 Character Code Table (Tabella codici carattere)
Consente di selezionare uno dei seguenti set di codici di caratteri.

6 International Character Set (Set di caratteri internazionale)
Elenca i set di caratteri per paesi specifici.
I seguenti codici variano a seconda del paese selezionato:
23h 24h 40h 5Bh 5Ch 5Dh 5Eh 60h 7Bh 7Ch 7Dh 7Eh
Per cambiare i caratteri, scaricare il documento "P-touch Template Manual/Command Reference" 
(Manuale per P-touch Template/Riferimento per i comandi) (solo in inglese) dalla pagina Manuali del 
modello in uso sul sito Brother Solutions Center all'indirizzo support.brother.com/manuals 

7 Command Prefix Character (Carattere prefisso comando)
Specifica il codice carattere del prefisso che identifica i comandi utilizzati in modalità P-touch Template.

8 Non-Printed Character (Carattere non stampato)
I caratteri specificati qui non vengono stampati al momento della ricezione dei dati (massimo 20 caratteri).

9 Available Return Code (Codice di rientro disponibile)
Il codice avanzamento riga è utilizzato durante l'inserimento dei dati per indicare che i seguenti dati vanno 
spostati sulla riga successiva in un oggetto testo. Selezionare uno dei quattro codici di avanzamento riga 
oppure digitare il codice avanzamento riga desiderato (massimo di 20 caratteri).

10 Replace FNC1 (Sostituire FNC1)
Sostituisce il codici GS con FNC1.

11 Number of Copies (Numero di copie)
Imposta il numero di copie (massimo 99 copie).

12 Opzione di taglio
Stabilisce se la stampante deve tagliare le etichette automaticamente e il numero di etichette da stampare 
prima del taglio (massimo 99 etichette).

13 Set (Imposta)
Applica le impostazioni alla stampante.
Per salvare le impostazioni specificate in un file di comando, selezionare Save in Command File 
(Salva nel file di comando) nell'elenco a discesa.

14 Cancel (Annulla)
Annulla le impostazioni e chiude la finestra di dialogo. Le impostazioni restano invariate.

15 Default (Impostazioni predefinite)
Riporta ai valori predefiniti tutti i valori di impostazione della finestra di dialogo Impostazioni 
P-touch Template.

http://support.brother.com/manuals
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Printer Setting Tool per Mac 5

Printer Setting Tool (Strumento di impostazione della stampante) permette di specificare le impostazioni 
di comunicazione della stampante e le impostazioni del dispositivo da un Mac. È possibile non solo modificare 
le impostazioni dispositivo per una stampante, ma anche applicare facilmente le stesse impostazioni a più 
stampanti.

Nota
Printer Setting Tool (Strumento di impostazione della stampante) viene installato automaticamente quando 
viene avviato il programma di installazione del driver stampante. Per ulteriori informazioni, vedere Installare 
i driver e il software della stampante su un computer a pagina 9.

IMPORTANTE

Printer Setting Tool (Strumento di impostazione della stampante) è disponibile solo per stampanti Brother 
compatibili.

Prima di usare lo Printer Setting Tool 5

 Accertarsi che il cavo di alimentazione CA sia collegato alla stampante e a una presa elettrica.

 Assicurarsi che il driver della stampante sia stato installato correttamente e che la stampa sia abilitata.

 Collegare la stampante a un computer tramite un cavo USB.

Uso di Printer Setting Tool per Mac 5

a Collegare al computer la stampante da configurare.

b Fare clic su Macintosh HD > Applicazioni > Brother > Printer Setting Tool (Strumento di impostazione 
della stampante) > Printer Setting Tool.app.
Viene visualizzata la finestra Printer Setting Tool (Strumento di impostazione della stampante).

c Controllare che la stampante da configurare sia presente accanto a Printer (Stampante). Se viene 
visualizzata una stampante diversa, selezionare la stampante desiderata dall'elenco popup.

d Selezionare una delle schede Impostazioni, quindi specificare o modificare le impostazioni desiderate.

e Fare clic sul Apply Settings to the Printer (Applica impostazione alla stampante) per applicare 
le impostazioni alla stampante.

f Fare clic su Exit (Esci).

IMPORTANTE

Printer Setting Tool (Strumento di impostazione della stampante) deve essere utilizzato per configurare 
la stampante solo quando questa è in fase di standby. Se si tenta di eseguire la configurazione mentre 
è in corso la stampa di un lavoro, la stampante potrebbe non funzionare correttamente.
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Finestra di dialogo delle impostazioni 5

1 Printer (Stampante)
Elenca le stampanti collegate.

2 Import (Importa)
Importa le impostazioni da un file.

3 Export (Esporta)
Salva in un file le impostazioni correnti.

4 Schede delle impostazioni
Contengono impostazioni che possono essere specificate o modificate.

5 Apply Settings to the Printer (Applica impostazione alla stampante...)
Applica le impostazioni alla stampante.

6 Factory Reset (Ripristina predefiniti)
Consente di ripristinare tutte le impostazioni ai valori di fabbrica, incluse le impostazioni del dispositivo 
e i dati trasferiti.

7 Print Unit Settings (Impostazioni unità di stampa)
Stampa un rapporto che contiene la versione del firmware e informazioni sulle impostazioni del dispositivo.
Questo rapporto può essere stampato anche mediante il pulsante taglierina ( ). Per ulteriori informazioni, 
vedere Conferma delle impostazioni della stampante di etichette a pagina 50.

Nota
Per stampare il rapporto, è consigliabile usare un rotolo DK da 62 mm o più grande.

8 Current Settings (Impostazioni correnti)
Recupera le impostazioni dalla stampante collegata correntemente e le visualizza nella finestra di dialogo.

9 Exit (Esci)
Chiude lo Printer Setting Tool (Strumento di impostazione della stampante).
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Scheda Basic (Base) 5

• Auto Power On (Accensione automatica)

Specifica se la stampante si accende automaticamente quando il cavo di alimentazione CA viene collegato 
a una presa elettrica.

• Auto Power Off (Spegnimento automatico)

Specifica quanto tempo trascorre prima che la stampante si spenga automaticamente quando è collegata 
a una presa elettrica.

Scheda Advanced (Avanzate) 5

• Print Data after Printing (Stampa dati dopo aver stampato)

Specifica se i dati di stampa vengono cancellati dopo la stampa.

• Printer Information Report (Rapporto informazioni stampante)

Consente di selezionare le informazioni da includere nel Printer Information Report (Rapporto informazioni 
stampante).

• Cut Settings (Impostazioni di taglio)

Imposta il metodo di taglio quando si stampano più etichette.

• Serialize Mode (Modalità di serializzazione)

Specifica la modalità di serializzazione desiderata (numero) delle etichette stampate.

Scheda Management (Gestione) 5

• Command Mode (Modalità di comando)

Consente di selezionare il tipo di modalità comando.
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Applicazione delle modifiche delle impostazioni a più stampanti di etichette 5

a Dopo aver applicato le impostazioni alla prima stampante, scollegare la stampante dal computer 
e collegare la seconda stampante al computer.

b Selezionare la stampante collegata di recente nell'elenco a discesa Printer (Stampante).

c Fare clic su Apply Settings to the Printer (Applica impostazione alla stampante).
Le stesse impostazioni che erano state applicate alla prima stampante vengono applicate alla seconda.

d Ripetere i passaggi da a a c per tutte le stampanti di cui si desidera modificare le impostazioni.

Nota
Per salvare le impostazioni correnti in un file, fare clic su Export (Esporta).

È possibile applicare le stesse impostazioni a un'altra stampante facendo clic su Import (Importa) 
e selezionando quindi il file delle impostazioni esportate. Per ulteriori informazioni, vedere Finestra di 
dialogo delle impostazioni a pagina 31.
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Modifica delle impostazioni per la stampa da un dispositivo 
mobile 5

Se si utilizza un dispositivo mobile, modificare le impostazioni in base alle necessità utilizzando l'applicazione 
prima della stampa. Le impostazioni modificabili variano in base all'applicazione.

Nota
Prima di collegare un dispositivo mobile, è possibile specificare le impostazioni dettagliate collegando 
la stampante a un computer e utilizzando lo Strumento di impostazione della stampante. Per ulteriori 
informazioni, vedere Modifica delle impostazioni della stampante di etichette a pagina 19.
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Funzionamento di P-touch Template 6

La modalità P-touch Template consente di inserire dati in oggetti testo e codice a barre da un modello scaricato 
mediante altri dispositivi collegati alla stampante di etichette.

Operazioni di base 6

 Stampa di modelli standard (vedere pagina 39)

Scaricare modelli o immagini utilizzati frequentemente ed eseguire scansioni di codici a barre per selezionare 
quale stampare.

 Stampa di modelli avanzata (vedere pagina 41)

Scaricare un modello ed eseguire la scansione di un codice a barre per stampare una copia o inserire i dati 
scansionati in un modello differente.

 Stampa con ricerca nel database (vedere pagina 44)

Scaricare un database collegato a un modello ed eseguire la scansione di un codice a barre per trovare 
un record da inserire in un modello e stampare tale modello.

Funzioni avanzate 6

 Stampa con numerazione (numero serializzato) (vedere pagina 47)

Consente di incrementare automaticamente un testo o i codici a barre stampati in qualsiasi modello scaricato.

Nota
• La modalità P-touch Template è compatibile anche con altri dispositivi di ingresso quali bilance, macchine 

per test, controller o dispositivi a logica programmabile.

• Per ulteriori informazioni, consultare "P-touch Template Manual/Command Reference" (Manuale per 
P-touch Template/Riferimento per i comandi). È possibile scaricare le ultime versioni dal Brother Solutions 
Center all'indirizzo support.brother.com/manuals 

Stampa di etichette usando P-touch 
Template 6

http://support.brother.com/manuals
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Preparazione 6

Prima di collegare lo scanner di codici a barre alla stampante, specificare le impostazioni dello scanner 
di codici a barre tramite le Impostazioni di P-touch Template (all'interno dello Strumento di impostazione 
della stampante).

Specificazione delle impostazioni nello strumento Impostazioni di P-touch 
Template 6

a Collegare la stampante e il computer con un cavo USB, quindi accendere la stampante.

b Avviare lo Strumento di impostazione della stampante.

 Per Windows 7:

Fare clic su Start > Tutti i programmi > Brother > Label & Mobile Printer > Printer Setting Tool 
(Strumento di impostazione della stampante).

 Per Windows 8 / Windows 8.1:

Nella schermata App, fare clic su Printer Setting Tool (Strumento di impostazione della stampante).

 Per Windows 10:

Fare clic su Start > Brother > Printer Setting Tool (Strumento di impostazione della stampante).

c Fare clic su Impostazioni P-touch Template.
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d Selezionare le impostazioni appropriate, quindi fare clic sul pulsante Set (Imposta).

Nota
• Per impostazione predefinita, la stampa che inizia con il codice "^FF" viene scansionata da un codice a barre 

tramite uno scanner di codici a barre. (Questa impostazione può essere modificata con le impostazioni 
evidenziate con A nell'immagine precedente.) 
Se si seleziona Received Data Size (Dimensioni dei dati ricevuti) ed è presente un'indicazione del numero 
di byte, il modello eseguirà la stampa automaticamente dopo aver scansionato il numero di byte indicato.

• Poiché la modalità di stampa viene riportata alla modalità raster ogni volta che si stampa dal computer, 
è necessario modificare nuovamente la modalità del modello.

• Se si spegne e si riaccende la stampante, questa si avvia in modalità modello.

(A)
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Collegamento di uno scanner di codici a barre 6

Si consiglia di utilizzare uno scanner di codici a barre affidabile e di qualità elevata e di verificare le specifiche 
dello scanner prima di scegliere uno specifico modello.

 Metodi di collegamento allo scanner di codici a barre:

Utilizzare l'interfaccia host USB.

 Criteri consigliati per la selezione dello scanner di codici a barre:

Se si utilizza l'interfaccia host USB: modelli classe HID identificabili come tastiera 

Nota
• Per la modalità P-touch Template, è necessario per prima cosa scaricare i modelli da un computer alla 

stampante, utilizzando P-touch Transfer Manager. Per ulteriori informazioni, vedere Come usare P-touch 
Transfer Manager e P-touch Library (solo Windows) a pagina 75.

• Lo scanner di codici a barre deve essere programmato in modo da utilizzare la tastiera inglese. 
Per i principianti, lo scanner di codici a barre deve essere programmato in modo da scansionare i dati 
senza alcun prefisso o suffisso. Gli utenti con competenze avanzate possono scansionare i caratteri 
del prefisso e del suffisso e utilizzarli come comandi con la stampante per creare modelli personalizzati.

• Per ulteriori informazioni su come utilizzare e programmare un modello di scanner di codici a barre 
specifico, contattare il produttore.
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Stampa di modelli standard 6

Scaricare modelli o immagini utilizzati frequentemente ed eseguire semplici scansioni di codici a barre per 
selezionare quale stampare.

Nota
• Per informazioni sui codici a barre che è possibile sottoporre a scansione con diverse impostazioni, vedere 

Elenco dei codici a barre per la funzione P-touch Template a pagina 122.

• Gli oggetti raggruppati saranno convertiti e inviati sotto forma di immagine.

a Mediante P-touch Transfer Manager, trasferire (da P-touch Editor) un modello (layout dell'etichetta) alla 
stampante. Per ulteriori informazioni, vedere Come usare P-touch Transfer Manager e P-touch Library 
(solo Windows) a pagina 75.

Nota
Un oggetto di testo nel layout dell'etichetta può essere convertito in un'immagine. Una volta convertito 
in un'immagine, il testo non può essere modificato. Questa funzione risulta utile per proteggere i modelli 
utilizzati di frequente contro le modifiche accidentali.

Nella finestra del layout di P-touch Editor, fare clic con il pulsante destro del mouse sull'oggetto di testo, 
quindi fare clic su Proprietà. Fare clic sulla scheda Espanse, quindi selezionare la casella di controllo 
Il testo non può essere modificato.

Se la scheda Espanse non viene visualizzata, fare clic su Strumenti > Opzioni > Generale. Nella sezione 
Altro, selezionare la casella di controllo Visualizza schede espanse delle proprietà oggetto.

Quando la casella di controllo è deselezionata, l'oggetto viene riconvertito in testo modificabile.

b Quando in P-touch Transfer Manager si trasferiscono dei dati alle Configurazioni, selezionare la cartella 
contenente i dati che si desidera trasferire.

Nota
• Quando in P-touch Transfer Manager si trasferisce un modello alle Configurazioni, il numero Codice 

assegnato viene assegnato automaticamente.

- Per le attività di base, è possibile specificare un numero Codice assegnato compreso tra 1 e 10.

- Per le operazioni avanzate, è possibile specificare un numero Codice assegnato compreso tra 1 e 99 
per qualsiasi modello scaricato sulla stampante, ma per selezionare e stampare tale codice, 
è necessario eseguire la scansione di diversi codici a barre nel passaggio f. Per ulteriori informazioni, 
scaricare il documento "P-touch Template Manual/Command Reference" (Manuale per P-touch 
Template/Riferimento per i comandi) (solo in inglese) dal sito Brother Solutions Center all'indirizzo 
support.brother.com/manuals 

• In Configurazioni è possibile aggiungere una cartella personalizzata e trascinare un modello trasferito 
nelle cartelle personalizzate così da gestire diversi set di modelli.

Esempio:

http://support.brother.com/manuals
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c Selezionando il modello trasferito e facendo clic su Trasferisci è possibile scaricare il modello sul numero 
Codice assegnato relativo alla stampante.

d Eseguire la scansione del codice a barre Comando P-touch Template (Inizializza + Inizia a specificare 
le impostazioni).
Vedere Elenco dei codici a barre per la funzione P-touch Template a pagina 122.

e Per inviare un comando o un'impostazione alla stampante, nell'elenco di codici a barre in Impostazioni 
di base, eseguire la scansione di tutti i codici a barre.

Nota
• È possibile configurare le impostazioni con più comandi.

• Se non viene configurata alcuna impostazione tramite la scansione dei comandi dei codici a barre, il modello 
viene stampato utilizzando le impostazioni P-touch Template. Le impostazioni di P-touch Template 
predefinite prevedono la stampa di una copia singola con la funzione Auto Cut (Taglio automatico) 
impostata su On (Attivo).

Per ulteriori informazioni sulle impostazioni di P-touch Template, scaricare il documento "P-touch Template 
Manual/Command Reference" (Manuale per P-touch Template/Riferimento per i comandi) (solo in 
inglese) dal sito Brother Solutions Center all'indirizzo support.brother.com/manuals 

• Per specificare il numero di copie desiderate, eseguire la scansione del codice a barre Numero di copie 
e quindi dei codici a barre in Per l'immissione dei numeri per specificare un numero di tre cifre.

Esempio:

Specificare i numeri eseguendo la scansione dei seguenti codici a barre: 7i[0][0][7], 15i[0][1][5].

• Per modificare l'impostazione per il numero di copie, eseguire nuovamente la scansione del codice a barre 
Numero di copie, quindi eseguire la scansione dei codici a barre per il nuovo numero a tre cifre.

f Eseguire la scansione del codice a barre in Numero modello preimpostato con lo stesso numero 
di Codice assegnato del layout di etichetta desiderato.

g L'etichetta specificata viene stampata.

http://support.brother.com/manuals
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Stampa di modelli avanzata 6

Scaricare un modello ed eseguire la scansione di un codice a barre per stampare una copia o inserire i dati 
scansionati in un modello differente.

Nota
• Per informazioni sui codici a barre che è possibile sottoporre a scansione con diverse impostazioni, vedere 

Elenco dei codici a barre per la funzione P-touch Template a pagina 122.

• Se un codice a barre presenta un protocollo diverso rispetto al modello di codici a barre già registrato con 
la stampante, potrebbe non essere possibile creare o stampare il codice a barre.

• In base ai modelli di scanner di codici a barre, è possibile che alcuni standard e protocolli per codici a barre 
non siano supportati dalla stampante in uso.

a Mediante P-touch Transfer Manager, trasferire (da P-touch Editor) un modello (layout dell'etichetta) alla 
stampante. Per ulteriori informazioni, vedere Come usare P-touch Transfer Manager e P-touch Library 
(solo Windows) a pagina 75.

IMPORTANTE

È importante progettare modelli che siano conformi ai requisiti richiesti per standard o protocolli per codici 
a barre. La dimensione dell'etichetta e la posizione del codice a barre sull'etichetta devono essere adatte 
per il numero e il tipo di caratteri inseriti tramite lo scanner di codici a barre. Un codice a barre nel modello 
non potrà essere creato o sottoposto a scansione se il codice a barre con i dati inseriti non rientra 
completamente all'interno dell'area dell'immagine stampabile dell'etichetta.

b Quando in P-touch Transfer Manager si trasferiscono dei dati alle Configurazioni, selezionare la cartella 
contenente i dati che si desidera trasferire.

Nota
• Quando in P-touch Transfer Manager si trasferisce un modello alle Configurazioni, il numero Codice 

assegnato viene assegnato automaticamente.

- È possibile specificare un numero Codice assegnato compreso tra 1 e 10 per qualsiasi modello scaricato 
sulla stampante.

• In Configurazioni è possibile aggiungere una cartella personalizzata e trascinare un modello trasferito 
nelle cartelle personalizzate così da gestire diversi set di modelli.

CODE128/9 cifre
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c Selezionando il modello trasferito e facendo clic su Trasferisci è possibile scaricare il modello sul numero 
Codice assegnato relativo alla stampante.

d Eseguire la scansione del codice a barre Comando P-touch Template (Inizializza + Inizia a specificare 
le impostazioni).
Per ulteriori informazioni, vedere Elenco dei codici a barre per la funzione P-touch Template a pagina 122.

e Per inviare un comando o un'impostazione alla stampante, nell'elenco di codici a barre in Impostazioni 
di base, eseguire la scansione di tutti i codici a barre.

Nota
• È possibile configurare le impostazioni con più comandi.

• Se non viene configurata alcuna impostazione tramite la scansione dei comandi dei codici a barre, il modello 
viene stampato utilizzando le impostazioni P-touch Template. Le impostazioni di P-touch Template 
predefinite prevedono la stampa di una copia singola con la funzione Auto Cut (Taglio automatico) 
impostata su On (Attivo).

Per ulteriori informazioni sullo Strumento di impostazione P-touch Template, scaricare il documento 
"P-touch Template Manual/Command Reference" (Manuale per P-touch Template/Riferimento per i 
comandi) (solo in inglese) dal sito Brother Solutions Center all'indirizzo support.brother.com/manuals 

• Per specificare il numero di copie desiderate, eseguire la scansione del codice a barre Numero di copie 
e quindi dei codici a barre in Per l'immissione dei numeri per specificare un numero di tre cifre. 
L'impostazione viene automaticamente applicata quando sono state specificate tre cifre.

Esempio:

Specificare i numeri eseguendo la scansione dei seguenti codici a barre: 7i[0][0][7], 15i[0][1][5].

• Per modificare l'impostazione per il numero di copie, eseguire nuovamente la scansione del codice a barre 
Numero di copie, quindi eseguire la scansione dei codici a barre per il nuovo numero a tre cifre.

f Eseguire la scansione del codice a barre Seleziona modello e quindi dei codici a barre in Per l'immissione 
dei numeri utilizzando lo stesso numero (di tre cifre) utilizzato in Codice assegnato per il modello scaricato 
da stampare.
Al termine della scansione dei numeri di tre cifre, il modello scaricato verrà selezionato 
automaticamente.
Esempio:
Specificare i numeri di tre cifre, eseguendo la scansione dei seguenti codici a barre: 7i[0][0][7], 
15i[0][1][5].

Nota
È possibile utilizzare P-touch Editor per creare e stampare un'etichetta con un singolo codice a barre 
per il passaggio f.

Esempio:

http://support.brother.com/manuals
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g Scansionare un codice a barre contenente i dati da inserire nell'oggetto codice a barre nel modello 
scaricato selezionato nel passaggio f.

Esempio:

h Per inviare il comando di avvio della stampa, eseguire la scansione del codice a barre Inizia a stampare.

i Il codice a barre nel modello stampato conterrà i dati dal codice a barre scansionato nel passaggio g.

Esempio:

(CODE128/9 cifre)
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Stampa con ricerca nel database 6

È possibile scaricare un database collegato a un modello ed eseguire la scansione di un codice a barre 
da usare come parola chiave per trovare un record contenente tale parola chiave e infine inserire il record 
nel modello e stamparlo.

Nota
• Nella stampante la colonna più a sinistra (A) di un database collegato scaricato è riservata a questa operazione; 

la parola chiave scansionata da un codice a barre, pertanto, deve trovarsi in questa colonna del database.

• Affinché la stampante possa trovare correttamente le parole chiave, i dati presenti nella colonna più 
a sinistra (A) devono corrispondere esattamente alle parole chiave scansionate da un codice a barre.

• Poiché P-touch Editor e la stampante possono leggere una sola linea di dati in ogni campo di un database 
collegato, non è consigliabile utilizzare dei database con due o più linee di dati nella colonna più a sinistra (A).

• Per informazioni sui codici a barre che è possibile sottoporre a scansione con diverse impostazioni, vedere 
Elenco dei codici a barre per la funzione P-touch Template a pagina 122.

a Utilizzare P-touch Editor per creare un modello e collegarsi al file di un database. È possibile collegare 
a un testo e a oggetti codice a barre del modello tutte le colonne necessarie.

Nota
Controllare che nella colonna più a sinistra (A) siano presenti le parole chiave, ma non collegarle 
a un oggetto testo o codice a barre nel modello mediante il campo (A) se non è necessario inserire i dati 
nell'etichetta stampata.

Per maggiori informazioni su come specificare le impostazioni, consultare la Guida di P-touch Editor.

b Mediante P-touch Transfer Manager, trasferire (da P-touch Editor) un modello (layout dell'etichetta) alla 
stampante. Per ulteriori informazioni, vedere Come usare P-touch Transfer Manager e P-touch Library 
(solo Windows) a pagina 75.
Verrà trasferito anche il file di database collegato.

c Quando in P-touch Transfer Manager si trasferisce un modello alle Configurazioni, il numero Codice 
assegnato viene assegnato automaticamente.

Nota
In Configurazioni è possibile aggiungere una cartella personalizzata e trascinare un modello trasferito 
nelle cartelle personalizzate così da gestire diversi set di modelli.

A
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d Selezionando il modello trasferito e facendo clic su Trasferisci è possibile scaricare il modello sul numero 
Codice assegnato relativo alla stampante.

e Eseguire la scansione del codice a barre Comando P-touch Template.
Per ulteriori informazioni, vedere Elenco dei codici a barre per la funzione P-touch Template 
a pagina 122.

f Per inviare un comando o un'impostazione alla stampante, nell'elenco di codici a barre in Impostazioni 
di base, eseguire la scansione di tutti i codici a barre.

Nota
• È possibile configurare le impostazioni con più comandi.

• Se non viene eseguita la scansione dei comandi dei codici a barre, il modello viene stampato utilizzando 
le impostazioni di P-touch Template. Le impostazioni di P-touch Template predefinite prevedono 
la stampa di una copia singola con la funzione Auto Cut (Taglio automatico) impostata su On (Attivo).

Per ulteriori informazioni sullo Strumento di impostazione P-touch Template, scaricare il documento 
"P-touch Template Manual/Command Reference" (Manuale per P-touch Template/Riferimento per i 
comandi) (solo in inglese) dal sito Brother Solutions Center all'indirizzo support.brother.com/manuals 

• Per specificare il numero di copie da stampare, eseguire la scansione del codice a barre Numero di copie 
e quindi dei codici a barre in Per l'immissione dei numeri per specificare un numero di tre cifre. 
L'impostazione viene automaticamente applicata quando sono state specificate tre cifre.

Esempio:

Specificare i numeri eseguendo la scansione dei seguenti codici a barre: 7i[0][0][7], 15i[0][1][5].

• Per modificare l'impostazione per il numero di copie, eseguire nuovamente la scansione del codice a barre 
Numero di copie, quindi eseguire la scansione dei codici a barre per il nuovo numero a tre cifre.

g Eseguire la scansione del codice a barre Seleziona modello e quindi dei codici a barre in Per l'immissione 
dei numeri utilizzando lo stesso numero (di tre cifre) utilizzato in Codice assegnato per il modello 
scaricato da stampare.
Al termine della scansione dei numeri di tre cifre, il modello scaricato verrà selezionato automaticamente.

Esempio:
Specificare i numeri di tre cifre, eseguendo la scansione dei seguenti codici a barre: 7i[0][0][7], 
15i[0][1][5].

Nota
È possibile utilizzare P-touch Editor per creare e stampare un'etichetta con un singolo codice a barre per 
il passaggio f.

Esempio:

http://support.brother.com/manuals
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h Eseguire la scansione di un codice a barre contenente la parola chiave da ricercare nel database scaricato 
nel passaggio d.
Esempio:

i Eseguire la scansione del codice a barre Delimitatore così da inviare il comando di avvio della ricerca 
della parola chiave scansionata nel database scaricato.

j Per inviare il comando di avvio della stampa, eseguire la scansione del codice a barre Inizia a stampare.

Nota
È possibile utilizzare P-touch Editor per creare e stampare un'etichetta con un singolo codice a barre 
secondo quando descritto nei passaggi i e j.

Esempio:

k La stampante stamperà il modello con i dati prelevati dal record di database corrispondente alla parola 
chiave scansionata.
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Stampa con numerazione (numero serializzato) 6

Quando si stampano modelli scaricati, è possibile incrementare in modo automatico un massimo di 999 copie 
di numeri testo o codici a barre. Selezionare gli oggetti testo e/o codice a barre da incrementare durante 
la stampa.

Numerazione del testo (Serializzazione) 6

a Utilizzare P-touch Editor per creare o aprire un modello e selezionare un oggetto testo da incrementare 
automaticamente durante la stampa.
Esempio:

b Evidenziare o trascinare il cursore su un gruppo di numeri e lettere all'interno dell'oggetto testo che 
si desidera incrementare (massimo 15). Il gruppo selezionato è chiamato campo Numerazione.

c Fare clic con il pulsante destro del mouse sul campo Numerazione e selezionare Numerazione.
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Numerazione del codice a barre (Serializzazione) 6

a Utilizzare P-touch Editor per creare o aprire un modello e selezionare un oggetto Codice a barre 
da incrementare automaticamente durante la stampa.

b Fare clic con il pulsante destro del mouse sull'oggetto codice a barre e selezionare Proprietà. 
Viene visualizzata la finestra di dialogo Proprietà - Codice a barre.

c Evidenziare o trascinare il cursore su un gruppo di numeri e lettere all'interno dell'oggetto codice a barre 
che si desidera incrementare (massimo 15). Il gruppo selezionato è chiamato campo Numerazione.

Nota
Dopo aver evidenziato un gruppo di numeri e lettere, il pulsante Numerazione si attiva.

d Fare clic su Numerazione, quindi fare clic su OK.
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Operazioni avanzate di Stampa con numerazione (Serializzazione) 6

a Mediante P-touch Transfer Manager, trasferire (da P-touch Editor) un modello (layout dell'etichetta) alla 
stampante. Per ulteriori informazioni, vedere Come usare P-touch Transfer Manager e P-touch Library 
(solo Windows) a pagina 75.

b Impostare la stampante affinché stampi utilizzando le operazioni avanzate di Stampa con numerazione 
(Serializzazione). Vedere Elenco dei codici a barre per la funzione P-touch Template a pagina 122.

 Eseguire la scansione prima del codice a barre serializzato e poi dei codici a barre in Per l'immissione 
dei numeri indicando il numero di copie da stampare (tre cifre).

Esempio:

Per stampare cinque copie, specificare il numero a tre cifre, scansionando i codici a barre relativi 
a [0][0][5].

Nota
• Per avviare la stampa, seguire le procedure del funzionamento di base nella modalità P-touch Template. 

Per ulteriori informazioni, vedere da Stampa di modelli standard a pagina 39 a Stampa con ricerca nel 
database a pagina 44.

• Il campo Numerazione verrà incrementato di un numero o una lettera alla stampa di ogni etichetta 
e il conteggio verrà salvato in modo permanente sulla stampante.

• Per riportare il conteggio di un oggetto testo o codice a barre al valore originale, eseguire la scansione 
del codice a barre Inizializza dati modello.
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7

Conferma delle impostazioni della stampante di etichette 7

È possibile stampare il rapporto delle impostazioni senza collegare la stampante a un computer o a un 
dispositivo mobile.

a Accendere la stampante.

b Caricare nella stampante un rotolo DK da 62 mm o più grande. Tenere premuto il pulsante taglierina ( ) 
per due secondi.

Inizia la stampa del rapporto.

Ritaglio stampa (etichette codici a barre) (solo Windows) 7

È possibile stampare uno o più codici a barre da un file PDF di grandezza A4 o Letter. La funzione Ritaglio 
stampa individua automaticamente i codici a barre specificati, che poi ritaglia e stampa singolarmente.

Nota
• La funzione Ritaglio stampa è disponibile solo quando si stampa dal driver della stampante di Windows 

e non può essere eseguita usando P-touch Editor.

• L'accuratezza della funzione Ritaglio stampa dipende dall'ambiente dell'utente, dal materiale di stampa e 
dal contenuto dell'etichetta. 

Si consiglia di utilizzare codici a barre chiari e in bianco e nero. 

Alcune etichette potrebbero non venire stampate correttamente o potrebbero differire dai dati originali in 
caso di condizioni non ottimali. 

Per ulteriori informazioni, visitare il sito Web di supporto Brother alla pagina support.brother.com.

Altre funzioni 7
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Codici a barre compatibili con Ritaglio stampa 7

• Codice 39/Codice 3 di 9

• ITF/ITF-14/interlacciato 2 di 5

• GS1-128 (UCC/EAN-128)

• Codabar (codice 2 di 7, NW-7)

• CODICE 93

• CODICE 128

• UPC-A

• UPC-E

• JAN-8/EAN-8

• JAN-13/EAN-13

• Codice QR 1

• Datamatrix/GS1 Datamatrix 1

• PDF417 1

• MaxiCode 1

1 Disponibile per le etichette di spedizione

Creazione di un documento codice a barre da utilizzare con Ritaglio stampa 7

Per utilizzare la funzione Ritaglio stampa, creare un documento codice a barre e salvarlo in formato PDF.

Accertarsi che il file PDF del codice a barre finale soddisfi i seguenti requisiti: 

Specifiche dei codici a barre

Proprietà Specifica

Larghezza verticale 5 mm (minimo)

Larghezza orizzontale La barra più stretta: 0,5 mm (minimo)

Margine 10 volte la larghezza della barra più stretta (minimo)

Colore Nero

Colore di sfondo Bianco

Larghezza cella (barra più larga) 0,5 mm (minimo)
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Condizioni dei codici a barre

Elemento Condizione

Quantità totale di codici a barre Tra 1 e 99 codici a barre.

Tipo di codice a barre Utilizzare solo i codici a barre compatibili con la funzione Ritaglio 
stampa.

Posizione dei codici a barre Accertarsi che i codici a barre non siano inclinati o in posizione 
angolata. Devono essere paralleli alla parte superiore e alla parte 
inferiore di ogni pagina. 

Accertarsi che i codici a barre inizino nell'angolo sinistro superiore e 
scorrano in basso lungo la colonna, continuando nella parte 
superiore della successiva colonna a destra.

Layout dei codici a barre

Layout corretto dei codici a barre Layout errato dei codici a barre

Non individuato (non allineato al margine superiore)

Condizioni dei codici a barre per le etichette di spedizione

Elemento Condizione

Numero totale di codici a barre Tra 1 e 9 codici a barre.

Tipo di codice a barre Utilizzare solo i codici a barre compatibili con la funzione Ritaglio stampa.

Posizione dei codici a barre Accertarsi che i codici a barre siano dritti.

D00XXU001 D00VXY004 D00ZXX003

D00XXU002 D00X0X001

D00XXU003 D00X0X002

D00XXU004 D00X0X003

D00VXY001 D00X0X004

D00VXY002 D00ZXX001

D00VXY003 D00ZXX002

D00XXU001

D00XXU002 D00X0X001

D00XXU003 D00X0X002 D00KYX001

D00XXU004 D00X0X003 D00KYX002

D00VXY001 D00X0X004 D00KYX003

D00VXY002 D00ZXX001 D00KYX004

D00VXY003 D00ZXX002 D00XXX001
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Layout dei codici a barre per le etichette di spedizione

Il ritaglio viene eseguito quando si verifica una delle seguenti condizioni:

• L'etichetta viene circondata da righe.

• L'etichetta include righe orizzontali che ne estendono la larghezza totale.

• L'etichetta include righe verticali che ne estendono la lunghezza totale.

Layout corretto dei codici a barre
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Etichette codici a barre utilizzando Ritaglio stampa 7

Nota
Accertarsi che la stampante sia collegata a un computer o a un dispositivo mobile mediante cavo USB 
o un collegamento di rete.

a Aprire il file PDF del documento codice a barre da stampare.

b Fare clic su File > Stampa.

c Fare clic sull'elenco a discesa Stampante e selezionare la stampante desiderata.

d Nella sezione Gestione e dimensioni pagina, selezionare il pulsante di scelta Dimensioni effettive.

e In Orientamento, selezionare il pulsante di scelta Verticale.

f Fare clic su Proprietà.

g Fare clic sulla scheda Base ed effettuare una delle seguenti operazioni: 

 Per le etichette pretagliate, deselezionare la casella di controllo Taglia ogni.

 Per i rulli continui, selezionare la casella di controllo Taglia ogni.

xx

xx
xx xx

xx xx

xx
xx

xx
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h Fare clic sulla scheda Ritaglio stampa e selezionare la casella di controllo Stampa automaticamente 
le singole etichette con i codici a barre. 

i Selezionare l'opzione Estrai etichette singole con codice a barre per le etichette prodotto o l'opzione 
Ritaglia codici a barre, testo e altri oggetti per le etichette di spedizione.

j Fare clic sull'elenco a discesa Formato etichetta/carta, quindi selezionare l'etichetta o il formato carta.

Se si seleziona l'opzione Ritaglia codici a barre, testo e altri oggetti, viene elencata solo la carta con 
larghezza 102 mm.

Nota
Selezionare le dimensioni di etichetta che più si avvicinano alle dimensioni originali dei dati di ritaglio. 
È consigliabile eseguire una prova prima di stampare un gran numero di etichette.

k Fare clic su OK.

l Stampa dalla schermata di stampa dell'applicazione.

IMPORTANTE

• Non ingrandire o ridurre le dimensioni del foglio codice a barre. I codici a barre potrebbero non essere 
individuati correttamente.

• Quando si stampa da Acrobat Reader, effettuare le seguenti operazioni:

- Nella sezione Gestione e dimensioni pagina, deselezionare la casella di controllo Scegli 
alimentazione secondo dimensioni pagina PDF.

- In Orientamento, selezionare il pulsante di scelta Verticale.

xx xx

xx xx
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Stampa distribuita (solo Windows) 7

Quando si stampa un numero elevato di etichette, la stampa può essere distribuita su più stampanti 
mediante USB, in modo da ridurre il tempo di stampa.

Nota
Il numero di pagine viene suddiviso tra le stampanti selezionate. Se il numero di pagine specificato 
non può essere suddiviso uniformemente tra le stampanti, verrà suddiviso nell'ordine delle stampanti 
come mostrato.

a In P-touch Editor, fare clic su File > Stampa.

b Fare clic su Proprietà…

c Fare clic sulla scheda Avanzate, poi selezionare la casella di controllo Stampa distribuita, quindi fare 
clic su Impostazioni.

67 67 66

200
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d Nella finestra di dialogo Impostazioni di stampa distribuita, selezionare le stampanti da usare per 
la stampa distribuita.

1 Fare clic su Rileva informazioni carta corrente… 
Le informazioni sulla stampante corrente rilevata appaiono sotto Carta corrente e Tipo stampante.

2 Selezionare la casella di controllo accanto al Nome stampante desiderato.

Nota
• Se la larghezza dell'etichetta selezionata è diversa da quella visualizzata nella colonna Carta corrente, 

viene visualizzata l'icona . Caricare la stampante con etichette della larghezza specificata tramite 
Imposta larghezza.

e Specificare le dimensioni dell'etichetta.

 Se è stata selezionata una sola stampante.

Nella finestra di dialogo Impostazioni di stampa distribuita descritta nel passaggio d, selezionare 
la stampante di cui si desidera specificare le impostazioni, quindi fare doppio clic su di essa oppure 
fare clic con il pulsante destro del mouse e selezionare Impostazioni. Dall'elenco a discesa Imposta 
larghezza, selezionare le dimensioni dell'etichetta.

Nota
Le informazioni visualizzate nella finestra di dialogo Impostazioni di stampa distribuita al passaggio d 
possono essere immesse nella casella di testo Note.

 Se sono state selezionate più stampanti.

Nella finestra di dialogo Impostazioni di stampa distribuita descritta nel passaggio d, selezionare 
le stampanti di cui si desidera specificare le impostazioni, quindi fare clic con il pulsante destro 
del mouse su di esse e selezionare Impostazioni. Dall'elenco a discesa Imposta larghezza, 
selezionare le dimensioni dell'etichetta. A tutte le stampanti selezionate viene applicata la stessa 
impostazione di dimensioni dell'etichetta.

Nota
Le impostazioni delle sezioni Impostazioni stampante e Note non sono disponibili.

2

1
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f Fare clic su OK per chiudere la finestra dell'impostazione delle dimensioni dell'etichetta.

g Fare clic su OK per chiudere la finestra Impostazioni di stampa distribuita.
L'impostazione è completata.

h Fare clic su OK per chiudere la finestra di dialogo delle Proprietà.

i Avviare stampa.

Nota
• Per una stampante collegata mediante un hub USB o un server di stampa, potrebbe non essere possibile 

rilevare le informazioni. Prima di stampare, immettere manualmente le impostazioni e verificare se la 
stampante può essere usata per la stampa.

• Si consiglia di eseguire un test di connessione per il proprio ambiente operativo. Per assistenza, contattare 
un responsabile IT o un amministratore.
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Per utilizzare la stampante di etichette con il computer è necessario installare P-touch Editor e il driver stampante.

Per informazioni sui driver e software più recenti, visitare il sito support.brother.com e accedere alla pagina 
Download del modello in uso.

Per Windows 8

Avvio di P-touch Editor 8

a Avviare P-touch Editor .

 Per Windows 7:

Fare clic su Start > Tutti i programmi > Brother P-touch > P-touch Editor 5.2 oppure fare doppio 
clic sull'icona di collegamento P-touch Editor 5.2 sul desktop.

 Per Windows 8 / Windows 8.1:

Fare clic su P-touch Editor 5.2 nella schermata App oppure fare doppio clic sull'icona P-touch 
Editor 5.2 sul desktop.

 Per Windows 10:

Fare clic su Start > P-touch Editor 5.2 in Brother P-touch oppure fare doppio clic sull'icona P-touch 
Editor 5.2 sul desktop.

b Quando si avvia P-touch Editor, selezionare se si desidera creare un nuovo layout o aprirne uno 
esistente.

Nota
Per modificare il comportamento di P-touch Editor all'avvio del programma, fare clic su Strumenti > Opzioni 
nella barra dei menu di P-touch Editor, per visualizzare la finestra di dialogo Opzioni. Sul lato sinistro, 
selezionare l'intestazione Generale, quindi l'impostazione desiderata nella casella di riepilogo Operazioni 
in Impostazioni di avvio. L'impostazione predefinita è Visualizza nuova vista.

Come usare P-touch Editor 8

http://support.brother.com/
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c Selezionare una delle opzioni visualizzate:

1 Per creare un nuovo layout, fare doppio clic su Nuovo layout oppure fare clic su Nuovo layout 
e quindi su →.

2 Per creare un nuovo layout usando un layout predefinito, selezionare un pulsante di categoria oppure 
selezionare un pulsante di categoria e poi fare clic su →.

3 Per collegare un layout predefinito a un database, selezionare la casella di controllo accanto 
a Connetti database.

4 Per aprire un layout esistente, fare clic su Apri.

2

1

3

4
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Stampa con P-touch Editor 8

 Modalità Express

Questa modalità consente di creare rapidamente layout contenenti testo e immagini.

Prima di stampare, configurare le impostazioni di stampa nella schermata Stampa. 
Per stampare, fare clic su File > Stampa nella barra dei menu oppure fare clic sull'icona Stampa. 

 Modalità Professional

Questa modalità consente di creare layout utilizzando un'ampia gamma di strumenti avanzati e opzioni.

Prima di stampare, configurare le impostazioni di stampa nella schermata Stampa. 
Per stampare, fare clic su File > Stampa nella barra dei menu oppure fare clic sull'icona Stampa (A).

Inoltre, è possibile fare clic sull'icona Stampa (B) per avviare la stampa senza modificare le impostazioni 
di stampa.

B

A
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 Modalità Snap

Questa modalità consente di catturare (interamente o in parte) il contenuto della schermata del computer, 
stamparlo come immagine e salvarlo per un utilizzo futuro.

a Fare clic sul pulsante di selezione della modalità Snap.
Viene visualizzata la finestra di dialogo Descrizione della modalità Snap.

b Fare clic su OK.
Viene visualizzata la palette della modalità Snap.

Trasferimento dei dati alla stampante di etichette 8

Per trasferire i dati alla stampante, è necessario utilizzare P-touch Transfer Manager. Per ulteriori informazioni, 
vedere P-touch Transfer Manager a pagina 75.
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Per Mac 8

Avvio di P-touch Editor 8

Fare doppio clic su Macintosh HD > Applicazioni e quindi sull'icona dell'applicazione P-touch Editor .

Nota
Se si utilizza un computer Mac, non è possibile trasferire alla stampante i dati delle etichette creati 
con P-touch Editor.

Quando si avvia P-touch Editor, selezionare se si desidera creare un nuovo layout o aprirne uno esistente.
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Modalità operative 8

 Modalità Standard

Questa modalità consente di creare etichette con testo e immagini.

La modalità Standard è composta dalle seguenti sezioni:

1 Barra degli strumenti

2 Ispezione etichette

3 Area connessione database

4 Ispezione oggetti

5 Finestra di layout

Trasferimento dei dati alla stampante di etichette 8

Per trasferire dei dati alla stampante, è necessario utilizzare un computer Windows. Per ulteriori informazioni, 
vedere P-touch Transfer Manager a pagina 75.

1

2

3 4

5
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Questa sezione descrive come creare in modo efficace le etichette dai contatti utilizzando P-touch Address 
Book. Le schermate possono variare in base al sistema operativo in uso.

(In alcune lingue, il modulo P-touch Address Book non è supportato.) 

Avvio di P-touch Address Book 9

a Avviare P-touch Address Book .

 Per Windows 7:

Fare clic su Start > Tutti i programmi > Brother P-touch > P-touch Address Book 1.3 oppure fare 
doppio clic sull'icona di collegamento P-touch Address Book 1.3 sul desktop.

 Per Windows 8 / Windows 8.1:

Fare clic su P-touch Editor 1.3 nella schermata App oppure fare doppio clic sull'icona P-touch 
Editor 1.3 sul desktop.

 Per Windows 10:

Fare clic su Start > P-touch Address Book 1.3 in Brother P-touch oppure fare doppio clic sull'icona 
P-touch Address Book 1.3 sul desktop.

b All'avvio di P-touch Address Book, viene visualizzata la finestra di dialogo Avvio, che consente 
di definire le impostazioni per creare nuovi contatti o importare contatti Outlook e dati nel formato CSV.

Come usare P-touch Address Book 
(solo Windows) 9
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c Nella finestra di dialogo Avvio, specificare l'operazione di P-touch Address Book da eseguire e fare clic 
sul pulsante OK.

 Quando si seleziona Crea nuovo contatto, viene visualizzata la finestra del layout.

 Quando si seleziona Importa contatti da file CSV o Importa contatti da Outlook, è possibile 
importare i contatti in altri formati.

 Fare clic sul pulsante Apri Guida… per aprire i file della Guida di P-touch Address Book.
La Guida di P-touch Address Book fornisce informazioni dettagliate sulle funzionalità disponibili 
e spiega come utilizzare P-touch Address Book.
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 Finestra di layout 

La finestra di layout è composta dalle seguenti sezioni:

1 Barra dei menu
I comandi sono suddivisi in categorie in ogni menu (File, Modifica, Visualizza, Layout e Strumenti) 
in base alle loro funzioni.

2 Barra degli strumenti Standard
Fornisce un gruppo di comandi utilizzati di frequente (come Nuovo contatto, Modifica contatto, 
Trova o Stampa).

3 Barra degli strumenti di testo
Consente di impostare gli attributi del testo, come le dimensioni dei font e l'allineamento 
per la formattazione del testo. 

4 Vista di selezione dello stile del layout
Visualizza gli stili del layout memorizzati nella cartella.

5 Area di lavoro layout
Consente di visualizzare o modificare un layout che utilizza lo stile del layout nella finestra 
di selezione dello stile del layout.

6 Casella combinata dell'elenco di contatti
Visualizza l'elenco di contatti specificato correntemente. È possibile scegliere tra Personale, 
Lavoro, Altro1, Altro2 e Altro3.

1

2

3

4

6

8

5

7
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7 Scheda Indice
È possibile cercare all'interno del campo in Visualizza record. Fare clic su Strumenti > Ordina 
per aprire la finestra di dialogo Ordina e specificare il campo desiderato mediante Chiave1.

8 Visualizza record
Visualizza i dati di contatto in ciascun campo. I dati possono anche essere modificati (aggiunti, 
eliminati o aggiornati).

Creazione di un nuovo contatto 9

In questa sezione viene spiegato come creare un nuovo contatto.

a Fare clic su File > Nuovo contatto oppure fare clic sul pulsante Nuovo contatto .

Viene visualizzata la finestra di dialogo Nuovo contatto.

b Immettere le informazioni relative al nuovo contatto.

1

2
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1 Barra degli strumenti Nuovo contatto
Nel menu sono raggruppati i seguenti comandi:

2 Modulo dei contatti
Consente di immettere informazioni quali nome, indirizzo, numero di telefono, dati dell'azienda 
e indirizzo e-mail per il nuovo contatto.

c Dopo aver finito di immettere i dati, fare clic sul pulsante Salva e chiudi  per memorizzarli.

Icona Nome pulsante Funzione

Precedente Visualizza il contatto precedente.

Successivo Visualizza il contatto successivo.

Nuovo contatto Visualizza la finestra del modulo che consente di creare un 
nuovo contatto.

Elimina contatto Elimina il contatto attualmente selezionato.

Image Consente di inserire un'immagine per un contatto da un file 
o una fotocamera collegata al computer.

Sono supportati i seguenti tipi di file:

• Bitmap (*.bmp, *.dib)

• File JPEG (*.jpg, *.jpeg)

• File TIFF (non compressi) (*.tif)

• File GIF (*.gif)

• Icona (*.ico)

• Metafile Windows (*.wmf, *.emf) (La regolazione di immagini 
non è consentita.)

• File PNG (*.png)

Salva e chiudi Salva il contatto e chiude la finestra di dialogo Nuovo contatto.
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Con P-touch Editor Lite è possibile creare in modo rapido e semplice vari layout etichetta senza installare 
alcun driver o software.

P-touch Editor Lite è supportato solo quando la stampante di etichette è connessa tramite un cavo USB.

Dopo avere collegato il cavo USB, sullo schermo del computer viene visualizzata una finestra di dialogo.

Per Windows 7 / Windows 8 / Windows 8.1 / Windows 10, fare clic su Apri cartella per visualizzare i file, 
quindi fare doppio clic su  (PTLITE10).

Si avvia P-touch Editor Lite.
* La stampante deve essere impostata sulla modalità P-touch Editor Lite. Tenere premuto il pulsante 

Editor Lite fino a quando la spia Editor Lite non si accende.

Finestra di layout

1 Barra degli strumenti dei comandi

2 Barra degli strumenti delle proprietà

3 Visualizzazione etichette

Come usare P-touch Editor Lite 
(solo Windows) 10

3

2

1
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1 Barra degli strumenti dei comandi

2 Barra degli strumenti delle proprietà

Icona Funzione

Visualizza la schermata di creazione di una nuova etichetta.

Apre un file salvato con P-touch Editor Lite.

Salva i dati sul computer, ma non sulla stampante.

Inserisce una nuova casella di testo (utile per creare etichette contenenti una o più righe di testo).

Inserisce un'immagine nell'etichetta.
Da file: inserisce un'immagine memorizzata nel computer.
Cattura schermo: inserisce l'area selezionata della schermata del computer come elemento grafico.
Simbolo: inserisce uno dei simboli incorporati del computer.

Inserisce una cornice.

Cambiare provvisoriamente la modalità per utilizzare P-touch Editor, quindi uscire da P-touch Editor Lite 
affinché si avvii P-touch Editor.
È necessario che P-touch Editor e il driver della stampante siano installati.

Visualizza il menu.
Il menu include tutte le funzionalità di P-touch Editor Lite.

Riduce a icona P-touch Editor Lite.

Esce da P-touch Editor Lite.

Icona Funzione

Fare clic su  per cambiare font.

Fare clic su  per specificare le dimensioni dei font.

È possibile incrementare o ridurre di un livello le dimensioni dei font facendo clic su  o .

/ Specifica lo stile dei font:

/  Grassetto /  Corsivo 

/  Sottolineato

Specifica l'allineamento del testo in una casella di testo.

Imposta la larghezza dell'etichetta. Fare clic su  per rilevare automaticamente la larghezza 
dell'etichetta inserita.

Imposta la lunghezza dell'etichetta. Fare clic su  per regolare automaticamente la lunghezza 
dell'etichetta in modo che possa contenere il testo immesso.
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3 Visualizzazione etichette

Imposta/annulla l'orientamento verticale delle etichette.

Fare clic su  per impostare il fattore di zoom per la visualizzazione etichette.

È anche possibile cambiare il fattore di zoom facendo clic su  o .

Fare clic su  per stampare normalmente, oppure su  per stampare specificando delle opzioni.
Taglio automatico: ciascuna etichetta viene automaticamente tagliata dopo la stampa.
Taglia alla fine: taglia le etichette dopo la stampa dell'ultima etichetta.
Copie: stampa più copie di un'etichetta.

Visualizzazione Funzione

Questa visualizzazione etichette compare all'avvio del software. La larghezza 
dell'etichetta utilizzata correntemente viene visualizzata a sinistra dell'immagine 
dell'etichetta. Quando a destra compare l'indicazione "Auto", la lunghezza dell'etichetta 
viene adattata automaticamente in base alla lunghezza del testo.

Per modificare manualmente la lunghezza e la larghezza dell'etichetta, spostare 
il puntatore sul bordo dell'area dell'etichetta, quindi trascinarla quando viene visualizzata 
la linea blu.

Per modificare la dimensione della finestra di P-touch Editor Lite, posizionare il puntatore 
sopra a un bordo della finestra e quando il puntatore diventa una freccia, trascinarlo.

Talvolta, mentre gli oggetti si spostano, vengono visualizzate delle indicazioni. 
Le indicazioni compaiono quando l'oggetto è allineato al bordo sinistro, destro, superiore 
o inferiore dell'area stampabile, oppure al centro. Nell'illustrazione a sinistra, 
le indicazioni segnalano che l'oggetto è centrato rispetto al bordo superiore dell'etichetta.

Le caselle di testo, le immagini e le cornici inserite vengono trattate come oggetti. 
Gli oggetti sono circondati da maniglie (indicate da otto punti blu). 

Indica che un oggetto è selezionato.

Quando viene spostato al di sopra di una maniglia, il puntatore si trasforma in una freccia. 
Per modificare la dimensione di un oggetto, trascinare le maniglie.

Per spostare gli oggetti, trascinarli quando il puntatore si trasforma in un mirino. 
Per gli oggetti di testo, il puntatore si trasforma in mirino solo quando è posizionato 
sul bordo dell'oggetto.

Icona Funzione
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Per selezionare e avviare le seguenti voci di menu, fare clic con il pulsante destro del mouse sull'area 
di visualizzazione del layout.

Altre funzioni (per visualizzarle, fare clic con il pulsante destro del mouse)

Menu Per eseguire la funzione

Annulla
Ripeti

Fare clic su Annulla per annullare l'ultima operazione.
Fare clic su Ripeti per ripetere l'ultima operazione.

Taglia
Copia
Incolla

Selezionare l'intera area di testo (o oggetto) da tagliare o copiare e selezionare Taglia 
o Copia. Fare clic nell'area di destinazione e selezionare Incolla.

Margini Questa funzione non è disponibile per questo modello.

Inserisc Fare clic su Inserisc.
Selezionare Casella di testo per inserire il testo nell'etichetta.
Selezionare Da file per inserire un'immagine memorizzata sul computer.
Selezionare Cattura schermo per selezionare e inserire un'area della schermata 
computer.
Selezionare Simbolo per inserire uno dei simboli incorporati del computer.
Selezionare Incorniciato per inserire una delle cornici incorporate in P-touch Editor Lite.

Direzione Selezionare l'oggetto testo e fare clic su Testo orizzontale o su Testo verticale per 
cambiare la direzione del testo.

Numerazione Selezionare il numero o la lettera all'interno del testo e fare clic su Numerazione per 

inserire un numero o una lettera incrementale su ciascuna etichetta. Fare clic su  
a destra del pulsante Stampare e fare clic su Opzioni di stampa. Selezionare la casella 
Numerazione e immettere il numero di etichette da stampare nel campo Conteggio. 
Fare clic sul pulsante Stampare.

Cambia immagine Selezionare l'immagine e fare clic su Cambia immagine per sostituire l'immagine 
corrente con un'immagine diversa.

Ruota Ruotare gli oggetti di 0°, 90°, 180° o 270°.

Ordine Selezionare uno degli oggetti e fare clic su Ordine, quindi selezionare Porta in primo 
piano, Porta in secondo piano, Porta avanti, oppure Porta indietro per impostare 
l'ordine di ciascun oggetto nel livello.

P-touch Editor... Cambiare provvisoriamente la modalità per utilizzare P-touch Editor, quindi uscire 
da P-touch Editor Lite affinché si avvii P-touch Editor.
È necessario che P-touch Editor e il driver della stampante siano installati.

Opzioni Fare clic su Opzioni.
Per definire l'impostazione dell'unità di misura, selezionare mm o pollici. 
Selezionare la lingua di P-touch Editor Lite. Per applicare la nuova "Lingua" selezionata, 
riavviare l'applicazione.
Selezionare Visualizza nuovo valore dopo la stampa o Ripristina il valore originale 
dopo la stampa per impostare l'opzione di numerazione.

Brother Solutions Center Fare clic su Brother Solutions Center per aprire il sito Web e richiedere aiuto 
e informazioni.

Informazioni su... Fare clic su Informazioni su per ottenere informazioni sulla versione di P-touch Editor Lite.

Esci Fare clic su Esci per uscire da P-touch Editor Lite.
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P-touch Transfer Manager 11

Questo programma consente di trasferire modelli e altri dati alla stampante di etichette e di salvare backup 
dei dati nel computer.

Come prima cosa P-touch Transfer Manager trasferisce i dati alla stampante, quindi P-touch Template invia 
i dati di testo che verranno inseriti nel modello e stampati. Per ulteriori informazioni su P-touch Template, 
scaricare il documento "P-touch Template Manual/Command Reference" (Manuale per P-touch 
Template/Riferimento per i comandi) (solo in inglese) dal sito Brother Solutions Center all'indirizzo 
support.brother.com/manuals 

Per poter usare P-touch Template è necessaria la funzione di trasferimento.

Trasferimento del modello a P-touch Transfer Manager 11

Per utilizzare P-touch Transfer Manager, è necessario trasferire prima i modelli creati in P-touch Editor 
in P-touch Transfer Manager.

a In P-touch Editor, aprire il modello desiderato.

b Fare clic su File > Trasferisci modello > Trasferisci.

Quando si avvia P-touch Transfer Manager, viene visualizzata la finestra principale.

Nota
Per avviare P-touch Transfer Manager, è possibile utilizzare anche il metodo seguente:

• Per Windows 7:

Fare clic su Start > Tutti i programmi > Brother P-touch > P-touch Tools > P-touch Transfer 
Manager 2.3.

• Per Windows 8 / Windows 8.1:

Fare clic su P-touch Transfer Manager 2.3 sulla schermata App.

• Per Windows 10:

Fare clic su Start > P-touch Transfer Manager 2.3 in Brother P-touch.

Come usare P-touch Transfer Manager 
e P-touch Library (solo Windows) 11

http://support.brother.com/manuals
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Finestra principale 11

1 Barra dei menu
Consente di accedere ai diversi comandi disponibili, suddivisi a seconda del titolo del menu (File, Modifica, 
Visualizza, Strumenti e [?] (Guida)) in base alle rispettive funzioni.

2 Barra degli strumenti
Consente di accedere ai comandi di uso frequente.

3 Area di selezione della stampante
Consente di selezionare la stampante sulla quale verranno trasferiti i dati. Quando si seleziona una 
stampante, nell'elenco dati vengono visualizzati solo i dati che è possibile inviare alla stampante 
selezionata.

4 Elenco cartelle
Visualizza un elenco di cartelle e stampanti. Quando si seleziona una cartella, i modelli contenuti nella 
cartella selezionata vengono visualizzati nell'elenco modelli.
Se si seleziona una stampante, vengono visualizzati i modelli correnti e altri dati memorizzati nella 
stampante.

5 Elenco modelli
Visualizza un elenco di modelli nella cartella selezionata.

6 Anteprima
Visualizza un'anteprima dei modelli contenuti nell'elenco modelli.

2

4

1

3

5

6
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Spiegazione delle icone della barra degli strumenti

Icona Nome pulsante Funzione

Trasferisci Trasferisce modelli e altri dati dal computer alla stampante.

Salva file di trasferimento

(Quando non è collegata 
una stampante)

Modifica il tipo di file dei dati da trasferire in altre applicazioni.

Quando si trasferiscono dati tramite Transfer Express (USB), 
selezionare PDZ.

Le interfacce disponibili variano a seconda del modello in uso.

Backup
Recupera i modelli e altri dati memorizzati nella stampante 
e li salva sul computer.

Apri Apre il modello selezionato.

Cerca
Esegue la ricerca di modelli e altri dati memorizzati in P-touch 
Library.

Stile visualizzazione Modifica lo stile di visualizzazione del file.
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Trasferimento di modelli o altri dati dal computer alla 
stampante di etichette 11

Per trasferire modelli, database e immagini dal computer alla stampante, effettuare le seguenti operazioni.

a Collegare il computer e la stampante tramite USB e accendere la stampante.
Il nome del modello della stampante viene visualizzato accanto all'icona della stampante nella 
visualizzazione cartella.
Se si seleziona una stampante nella visualizzazione cartella, vengono visualizzati i modelli correnti e altri 
dati memorizzati nella stampante.

Nota
• Se una stampante è scollegata o offline, non viene elencata nella visualizzazione cartella.

• Prima del trasferimento dei dati, verificare che il computer e la stampante siano collegati correttamente 
con un cavo USB e che la stampante sia accesa.

b Selezionare la stampante alla quale devono essere trasferiti il modello e altri dati.
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c Fare clic con il pulsante destro del mouse sulla cartella Configurazioni, selezionare Nuovo, quindi 
creare una nuova cartella.

d Trascinare il modello o i dati da trasferire nella nuova cartella.

Specifica della funzione di trasferimento

Tipo dati
Numero massimo di elementi 

trasferibili
Dettagli limitazione

Modello 99 Ciascun modello può contenere al massimo 50 oggetti.

Database 99

 Possono essere trasferiti solo i file *.csv.

 Ciascun file *.csv può contenere al massimo 65.000 
record.

Immagine 
(simboli trasferiti)

99

 Possono essere trasferiti solo i file *.bmp.

 Si consigliano i file *.bmp monocromatici.

 La dimensione massima è 1296 × 1296 pixel.

 Le immagini molto grandi possono essere ritagliate.
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Nota
È possibile verificare lo spazio disponibile nella memoria dei file di trasferimento stampando il report sulle 
impostazioni della stampante. Per ulteriori informazioni, vedere Conferma delle impostazioni della 
stampante di etichette a pagina 50. 
Per verificare quanto spazio è disponibile, vedere RomFree 1.
1 Lo spazio disponibile visualizzato sulla riga "RomFree = ******* byte" potrebbe essere diverso dall'effettivo spazio disponibile.

È possibile visualizzare i modelli e altri dati selezionando:

 La cartella nella cartella Configurazioni

 Tutti i file 

 Una delle categorie in Filtro, come ad esempio Layout

Quando si trasferiscono più modelli o altri dati, è possibile trascinare tutti i file desiderati nella nuova cartella.

Al momento del trasferimento della nuova cartella, a ogni file viene assegnato un numero chiave 
(posizione nella memoria della stampante).
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e Per modificare il numero di chiave assegnato a un determinato elemento, fare clic con il pulsante destro 
del mouse sull'elemento, selezionare Codice assegnato, quindi selezionare il numero chiave desiderato.

Nota
• Tranne per i dati dei database, a tutti i dati trasferiti alla stampante viene assegnato un numero chiave.

• Se al modello o ai dati trasferiti alla stampante viene assegnato un numero chiave già associato a un altro 
modello precedentemente salvato nella stampante, il vecchio modello viene sovrascritto da quello nuovo. 
È possibile verificare i numeri chiave assegnati ai modelli già salvati nella stampante eseguendo il backup 
dei modelli e degli altri dati. Per ulteriori informazioni, vedere Backup dei modelli o di altri dati memorizzati 
nella stampante di etichette a pagina 83.

• Se la memoria della stampante è piena, rimuovere uno o più modelli dalla memoria della stampante. 
Per ulteriori informazioni, vedere Backup dei modelli o di altri dati memorizzati nella stampante di etichette 
a pagina 83.

f Per modificare i nomi dei modelli o altri dati da trasferire, fare clic sull'elemento desiderato e digitare 
un nuovo nome. Il numero di caratteri utilizzabili per i nomi dei modelli potrebbe essere soggetto 
a dei limiti in base al modello della stampante.
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g Selezionare la cartella contenente i modelli o i dati da trasferire, quindi fare clic su Trasferisci. Viene 
visualizzato un messaggio di conferma.

Nota
• È possibile inoltre trasferire singoli elementi alla stampante senza aggiungerli ad alcuna cartella. 

Selezionare il modello o i dati da trasferire, quindi fare clic su Trasferisci.

• È possibile selezionare più elementi o più cartelle e trasferirli mediante una sola operazione.

h Fare clic su OK.

Gli elementi selezionati vengono trasferiti alla stampante.
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Backup dei modelli o di altri dati memorizzati nella stampante 
di etichette 11

La seguente procedura consente di recuperare i modelli o altri dati memorizzati nella stampante e di salvarli 
sul computer.

IMPORTANTE

• I modelli e i dati di backup non possono essere modificati nel computer.

• A seconda del modello di stampante, potrebbe non essere possibile trasferire i modelli o i dati salvati 
a un modello differente.

a Collegare il computer e la stampante e accendere la stampante.
Il nome del modello della stampante viene visualizzato accanto all'icona della stampante nella 
visualizzazione cartella.
Se si seleziona una stampante nella visualizzazione cartella, vengono visualizzati i modelli correnti 
e altri dati memorizzati nella stampante.

b Selezionare la stampante da cui eseguire il backup, quindi fare clic su Backup.
Viene visualizzato un messaggio di conferma.

c Fare clic su OK.
Nella visualizzazione cartella viene creata una nuova cartella per la stampante. Il nome di tale cartella 
è composto dalla data e dall'ora del backup. Tutti i modelli della stampante e gli altri dati vengono 
trasferiti nella nuova cartella e salvati sul computer.
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Eliminazione di dati dalla stampante di etichette 11

Per eliminare tutti i modelli o gli altri dati memorizzati sulla stampante, effettuare le seguenti operazioni.

a Collegare il computer e la stampante e accendere la stampante.
Il nome del modello della stampante viene visualizzato accanto all'icona della stampante nella 
visualizzazione cartella.

b Fare clic con il pulsante destro del mouse sulla stampante e selezionare Elimina tutto.

Viene visualizzato un messaggio di conferma.

c Fare clic su OK.
Tutti i modelli e i dati memorizzati sulla stampante vengono eliminati.
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Creazione di file pacchetto per trasferimento 11

Con P-touch Transfer Manager è possibile salvare in formato .pdz i dati del modello creati mediante P-touch 
Editor. I file in questo formato possono essere trasferiti a una stampante da un computer o da un dispositivo 
mobile.

a Creare il modello utilizzando P-touch Editor, quindi trasferirlo in P-touch Transfer Manager.
Per ulteriori informazioni, vedere Trasferimento del modello a P-touch Transfer Manager a pagina 75.

b Senza collegare la stampante al computer, selezionare Configurazioni nella finestra P-touch Transfer 
Manager, quindi selezionare il modello da salvare.

Nota
È possibile selezionare modelli contemporaneamente.

c Fare clic su File > Salva file di trasferimento.

IMPORTANTE

Il pulsante Salva file di trasferimento viene visualizzato solo se la stampante è scollegata dal computer 
o è offline.

Nota
• Se si fa clic su Salva file di trasferimento dopo avere selezionato Configurazioni, tutti i modelli nella 

cartella vengono salvati come file pacchetto di trasferimento (.pdz).

• È possibile riunire in un unico file pacchetto di trasferimento vari modelli (.pdz).

d In Salva come, selezionare il formato di modello desiderato, quindi digitare il nome e salvare il modello.
I modelli vengono salvati come file pacchetto di trasferimento (.pdz).
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P-touch Library 11

Questo programma consente di gestire e stampare i modelli P-touch Editor.

Avvio di P-touch Library 11

 Per Windows 7:

Fare clic su Start > Tutti i programmi > Brother P-touch > P-touch Tools > P-touch Library 2.3.

 Per Windows 8 / Windows 8.1:

Nella schermata App, fare clic su P-touch Library 2.3.

 Per Windows 10:

Fare clic su Start > P-touch Library 2.3 in Brother P-touch.

All'avvio di P-touch Library viene visualizzata la finestra principale.

Finestra principale 11

1 Barra dei menu
Consente di accedere a tutti i comandi disponibili, suddivisi a seconda del titolo del menu (File, Modifica, 
Visualizza, Strumenti e [?] (Guida)) in base alle rispettive funzioni.

2 Barra degli strumenti
Consente di accedere ai comandi di uso frequente.

3 Elenco cartelle
Visualizza un elenco di cartelle. Quando si seleziona una cartella, i modelli contenuti nella cartella 
selezionata vengono visualizzati nell'elenco modelli.

2

3

1

4

5
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4 Elenco modelli
Visualizza un elenco di modelli nella cartella selezionata.

5 Anteprima
Visualizza un'anteprima dei modelli selezionati nell'elenco modelli.

Spiegazione delle icone della barra degli strumenti

Icona Nome pulsante Funzione

Apri Apre il modello selezionato.

Stampa Stampa il modello selezionato utilizzando la stampante.

Cerca Esegue la ricerca di modelli memorizzati in P-touch Library.

Stile visualizzazione Modifica lo stile di visualizzazione del file.
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Apertura e modifica dei modelli 11

Selezionare il modello da aprire o modificare, quindi fare clic su Apri.

Viene avviato il programma associato al modello ed è possibile modificare il modello.
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Stampa dei modelli 11

Selezionare il modello da stampare, quindi fare clic su Stampa.

La stampante collegata stampa il modello.
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Ricerca di modelli 11

È possibile eseguire la ricerca di modelli registrati in P-touch Library.

a Fare clic su Cerca.
Viene visualizzata la finestra di dialogo Cerca.

b Specificare i parametri di ricerca.
I parametri di ricerca disponibili sono i seguenti:

c Fare clic su Inizia ricerca.
Viene avviata la ricerca e vengono visualizzati i risultati della ricerca.

Impostazioni Dettagli

Parametri multipli Determina il metodo di ricerca nel caso in cui vengano specificate più condizioni. 
Se si seleziona E, vengono cercati i file che soddisfano tutte le condizioni. 
Se si seleziona O, vengono cercati i file che soddisfano una delle condizioni.

Nome Consente di cercare un modello in base al nome del file.

Tipo Consente di cercare un modello in base al tipo di file.

Dimensioni Consente di cercare un modello in base alle dimensioni del file.

Data Consente di cercare un modello in base alla data del file.
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d Chiudere la finestra di dialogo Cerca.
È possibile confermare i risultati della ricerca facendo clic su Risultati ricerca nella visualizzazione 
cartella.

Nota
È possibile registrare i modelli in P-touch Library trascinandoli e nella cartella Tutti i file o nell'elenco delle 
cartelle. Per configurare P-touch Editor in modo che i modelli vengano registrati automaticamente 
in P-touch Library, effettuare le seguenti operazioni:

1 Dal menu P-touch Editor, selezionare Strumenti > Opzioni.

2 Nella finestra di dialogo Opzioni, fare clic sull'opzione Generale > Impostazioni di registrazione.

3 Specificare quando devono essere registrati i modelli creati con P-touch Editor, quindi fare clic su OK.
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È possibile trasferire i modelli alla stampante di etichette utilizzando P-touch Transfer Express. Come prima 
cosa, l'amministratore crea un modello, poi lo distribuisce insieme a P-touch Transfer Express. È quindi 
possibile usare P-touch Transfer Express per trasferire il modello direttamente alla stampante in dotazione.

Per scaricare l'ultima versione di P-touch Transfer Express, visitare il sito web support.brother.com 
e accedere alla pagina Download del modello in questione.

IMPORTANTE

• Quando si trasferisce un nuovo modello, specificare un numero Codice assegnato (in P-touch Transfer 
Manager) non ancora utilizzato. Se il numero Codice assegnato è già in uso, il modello esistente verrà 
sovrascritto dal nuovo modello.

• Questa funzione richiede una connessione USB.

Preparazione di P-touch Transfer Express 12

L'utente deve preparare P-touch Transfer Express per il trasferimento dei modelli a una stampante.

IMPORTANTE

• È necessario installare il driver stampante prima di utilizzare Transfer Express.

• P-touch Transfer Express è disponibile solo in lingua inglese.

Per scaricare l'ultima versione di P-touch Transfer Express, visitare il sito web support.brother.com 
e accedere alla pagina Download del modello in questione.

a Scaricare Transfer Express su qualsiasi posizione sul computer.

b Decomprimere il file scaricato (.zip).

Come trasferire i modelli con P-touch 
Transfer Express (solo Windows) 12

Amministratore Utenti

Brother Solutions Center
support.brother.com

P-touch
 Editor

P-touch 
Transfer Manager

Transfer Express

xxx.lbx xxx.lbx xxx.pdz

1.

2. 3. 4. 5.

P-touch 
Transfer Express

xxx.pdz

http://support.brother.com/
http://support.brother.com/
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Trasferimento del modello a P-touch Transfer Manager 12

a In P-touch Editor, aprire il modello che si desidera utilizzare.

b Fare clic su File > Trasferisci modello > Trasferisci.

Il modello viene trasferito in P-touch Transfer Manager.
P-touch Transfer Manager si avvia automaticamente.

Nota
• Per Windows 7: 

È possibile trasferire un modello a P-touch Transfer Manager anche facendo clic su Start > Tutti 
i programmi > Brother P-touch > P-touch Tools > P-touch Transfer Manager 2.3 per avviare 
P-touch Transfer Manager e trascinando quindi il file .lbx sulla finestra P-touch Transfer Manager.

• Per Windows 8 / Windows 8.1: 

È possibile trasferire un modello a P-touch Transfer Manager anche facendo clic su P-touch Transfer 
Manager 2.3 nella schermata App per avviare P-touch Transfer Manager e trascinando quindi il file .lbx 
sulla finestra P-touch Transfer Manager.

• Per Windows 10: 

È possibile trasferire un modello a P-touch Transfer Manager anche facendo clic su Start > Tutti 
i programmi > Brother P-touch > P-touch Transfer Manager 2.3 per avviare P-touch Transfer 
Manager e trascinando quindi il file .lbx sulla finestra P-touch Transfer Manager.
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Salvataggio di un modello come file pacchetto 
di trasferimento (.pdz) 12

Per creare un file in un formato utilizzabile da P-touch Transfer Express, salvare il modello come file 
pacchetto di trasferimento (.pdz).

a Nella visualizzazione cartella, selezionare Configurazioni.

b Selezionare i modelli da distribuire.
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c Fare clic su File > Salva file di trasferimento.

IMPORTANTE

L'opzione Salva file di trasferimento viene visualizzata solo se la stampante è scollegata dal computer 
o è offline.

Nota
• Se si fa clic su Salva file di trasferimento mentre è selezionata l'opzione Configurazioni o una cartella 

creata, tutti i modelli vengono salvati come file pacchetto di trasferimento (.pdz).

• È possibile riunire in un unico file pacchetto di trasferimento vari modelli (.pdz).

d Digitare il nome, quindi fare clic su Salva.

Il modello viene salvato come file pacchetto di trasferimento (.pdz).
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Distribuzione ad altri del file pacchetto di trasferimento (.pdz) 
e di P-touch Transfer Express 12

Nota
Se l'utente ha già scaricato P-touch Transfer Express, non è necessario che l'amministratore invii 
la cartella Transfer Express. In tal caso, l'utente può semplicemente spostare il file pacchetto 
di trasferimento distribuito nella cartella scaricata e fare quindi doppio clic su PtTrExp.exe.

a Spostare il file pacchetto di trasferimento (.pdz) nella cartella dei download.

b Distribuire ad altri tutti i file presenti nella cartella dei download.
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Trasferimento del file pacchetto di trasferimento (.pdz) alla 
stampante di etichette 12

Usando l'applicazione P-touch Transfer Express ricevuta dall'amministratore, l'utente può trasferire il file 
pacchetto di trasferimento (.pdz) alla stampante.

IMPORTANTE

Durante il trasferimento dei modelli, non spegnere l'apparecchiatura.

a Accendere la stampante.

b Usando un cavo USB, collegare la stampante al computer.

c Fare doppio clic sul file PtTrExp.exe ricevuto dall'amministratore.

d Trasferire il file pacchetto di trasferimento (.pdz) alla stampante.

 Trasferimento di un unico file pacchetto di trasferimento (.pdz)

1 Se all'interno della cartella contenente PtTrExp.exe è presente un solo file pacchetto 
di trasferimento (.pdz), fare clic su Transfer (Trasferisci).

2 Ha inizio il trasferimento del file pacchetto di trasferimento.
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 Trasferimento di numerosi file pacchetto di trasferimento (.pdz)

1 Se all'interno della cartella contenente il file PtTrExp.exe sono presenti più file pacchetto 
di trasferimento (.pdz), fare clic su Browse (Sfoglia).

2 Selezionare il file pacchetto di trasferimento da trasferire, quindi fare clic su Apri.

3 Fare clic su Transfer (Trasferisci).
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4 Fare clic su Yes (Sì).

5 Ha inizio il trasferimento del file pacchetto di trasferimento.

e Al termine del trasferimento, fare clic su OK.
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Il software può essere aggiornato alla versione più recente disponibile usando P-touch Update Software.

Nota
• Il software e i contenuti effettivi del manuale potrebbero variare.

• Non spegnere l'apparecchio durante il trasferimento dei dati o l'aggiornamento del firmware.

Aggiornamento di P-touch Editor e P-touch Address Book 
(solo Windows) 13

IMPORTANTE

Prima di aggiornare P-touch Editor e P-touch Address Book, installare il driver della stampante. 

a Avviare P-touch Update Software.

 Per Windows 7:

Fare doppio clic sull'icona P-touch Update Software.

Nota
Il seguente metodo può essere utilizzato anche per avviare P-touch Update Software:

Fare clic su Start > Tutti i programmi > Brother P-touch > P-touch Update Software.

 Per Windows 8 / Windows 8.1:

Fare clic su P-touch Update Software nella schermata App oppure fare doppio clic su P-touch 
Update Software sul desktop.

 Per Windows 10:

Fare clic su Start > Brother P-touch > P-touch Update Software o fare doppio clic su P-touch 
Update Software sul desktop.

Come aggiornare P-touch Software 13
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b Fare clic sull'icona Aggiornamento software computer.

c Selezionare un valore per Stampante e Lingua, poi selezionare le caselle di controllo accanto a P-touch 
Editor e P-touch Address Book, quindi fare clic su Installa.

d Viene visualizzato un messaggio che indica che l'installazione è terminata.
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Aggiornamento di P-touch Editor Lite (solo Windows) 
e del firmware 13

IMPORTANTE

• Prima di aggiornare il firmware, è necessario installare il driver della stampante.

• Non spegnere l'apparecchio durante il trasferimento dei dati o l'aggiornamento del firmware.

• Se è in esecuzione un'altra applicazione, uscire dall'applicazione stessa.

Per Windows 13

a Accendere la stampante e collegare il cavo USB.

b Avviare P-touch Update Software.

 Per Windows 7:

Fare doppio clic sull'icona P-touch Update Software.

Nota
Il seguente metodo può essere utilizzato anche per avviare P-touch Update Software: 
Fare clic su Start > Tutti i programmi > Brother P-touch > P-touch Update Software.

 Per Windows 8 / Windows 8.1:

Fare clic su P-touch Update Software nella schermata App oppure fare doppio clic su P-touch 
Update Software sul desktop.

 Per Windows 10:

Fare clic su Start > Brother P-touch > P-touch Update Software o fare doppio clic su P-touch 
Update Software sul desktop.
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c Fare clic sull'icona Aggiornamento dispositivo.

d Selezionare Stampante, controllare che venga visualizzato il messaggio Il dispositivo è collegato 
correttamente., quindi fare clic su OK.
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e Selezionare un valore per Lingua, selezionare la casella di controllo accanto al firmware da aggiornare, 
quindi fare clic su Trasferisci.

IMPORTANTE

Durante il trasferimento dei dati, non spegnere la stampante e non scollegare il cavo.

f Controllare il contenuto da aggiornare, quindi fare clic su Avvia per avviare l'aggiornamento. 
L'aggiornamento del firmware viene avviato.

IMPORTANTE

Non spegnere la stampante e non scollegare il cavo durante il processo di aggiornamento.

Per Mac 13

a Accendere la stampante e collegare il cavo USB.

b Fare doppio clic su Macintosh HD > Applicazioni > P-touch Update Software e quindi fare doppio 
clic sull'icona dell'applicazione P-touch Update Software.
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c Fare clic sull'icona Aggiornamento dispositivo.

d Selezionare Stampante, controllare che venga visualizzato il messaggio Il dispositivo è collegato 
correttamente., quindi fare clic su OK.

e Selezionare un valore per Lingua, selezionare la casella di controllo accanto al firmware da aggiornare, 
quindi fare clic su Trasferisci.

IMPORTANTE

Durante il trasferimento dei dati, non spegnere la stampante e non scollegare il cavo.

f Controllare il contenuto da aggiornare, quindi fare clic su Avvia per iniziare l'aggiornamento. 
L'aggiornamento del firmware viene avviato.

Nota
Non spegnere la stampante durante il processo di aggiornamento.
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Il ripristino della memoria interna della stampante è indicato per eliminare tutti i file di etichetta salvati 
e qualora la stampante non funzioni correttamente.

Ripristino di tutte le impostazioni ai valori predefiniti 
di fabbrica mediante i pulsanti della stampante di etichette 14

Per reimpostare la stampante, eseguire le seguenti operazioni.

a Spegnere la stampante.

b Premere contemporaneamente il pulsante di alimentazione ( ) e il pulsante taglierina ( ) per circa 
un secondo. Il LED di stato si accenderà in arancione e il LED di Editor Lite lampeggerà in verde.

c Continuare a tenere premuto il pulsante di alimentazione ( ) e premere sei volte il pulsante taglierina ( ). 

d Rilasciare il pulsante di alimentazione ( ). Il LED di stato si accenderà in arancione e il LED di Editor Lite 
lampeggerà in verde. Successivamente, il LED di stato si accenderà in arancione e il LED di Editor Lite 
si accenderà in verde.

Ripristino dei dati mediante lo Strumento di impostazione 
della stampante 14

Inoltre, è possibile usare lo Strumento di impostazione della stampante dal computer per ripristinare tutte 
le impostazioni della stampante sui valori di fabbrica.

Per ulteriori informazioni, vedere Ripristina predefiniti... a pagina 24.

Ripristino della stampante di etichette 14
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Consigliamo di pulire la stampante a cadenza regolare per garantire prestazioni sempre ottimali.

Nota
Scollegare sempre il cavo di alimentazione CA prima di pulire la stampante.

Pulizia delle parti esterne dell'unità 15

Rimuovere la polvere ed eventuali macchie dall'unità principale servendosi di un panno morbido e asciutto.

Per rimuovere i segni ostinati, utilizzare un panno leggermente bagnato con acqua.

Nota
Non usare diluenti, benzene, alcol o qualsiasi altro solvente organico.

Questi prodotti potrebbero danneggiare la custodia esterna della stampante.

Pulizia dell'uscita delle etichette 15

Se un'etichetta provoca l'inceppamento della macchina a causa della colla attaccata sulla fessura di uscita 
delle etichette, scollegare il cavo dell'alimentazione dalla macchina e pulire con un panno o bastoncino 
di cotone imbevuto di alcol.

Manutenzione 15
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Pulizia del rullo 15

Tagliare l'etichetta DK e rimuovere il supporto dall'etichetta. Dopodiché, mettere il lato adesivo dell'etichetta 
contro il rullo e rimuovere lo sporco.

Pulizia automatica della testina di stampa 15

Il rotolo DK (carta termica) utilizzato con la macchina è studiato per pulire automaticamente la testina di stampa. 
Quando il rotolo DK oltrepassa la testina di stampa durante la stampa e l'avanzamento di etichette, la testina 
di stampa viene pulita.
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Panoramica 16

In questo capitolo è spiegato come risolvere i problemi tipici che si possono verificare durante l'utilizzo della 
stampante di etichette. Se si riscontrano problemi con la stampante, controllare dapprima di avere eseguito 
le seguenti operazioni in modo corretto.

 Collegare la stampante a una presa elettrica. Per ulteriori informazioni, vedere Collegamento del cavo 
di alimentazione a pagina 4.

 Rimuovere tutto l'imballaggio di protezione dalla stampante.

 Installare e selezionare il driver della stampante corretto. Per ulteriori informazioni, vedere Installare i driver 
e il software della stampante su un computer a pagina 9.

 Collegare la stampante a un computer o dispositivo mobile. Per ulteriori informazioni, vedere 
Collegamento della Stampante di etichette a un computer a pagina 9.

 Chiudere completamente il coperchio del vano del rotolo DK.

 Inserire correttamente un rotolo DK. Per ulteriori informazioni, vedere Caricamento del rotolo DK a pagina 5.

Se i problemi persistono, leggere i consigli sulla risoluzione dei problemi contenuti in questo capitolo. 
Se, dopo aver letto questo capitolo, non si riesce a risolvere il problema, visitare il Brother Solutions Center 
alla pagina support.brother.com 

Risoluzione dei problemi 16

http://support.brother.com/
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Indicazioni dei LED 16

Gli indicatori si illuminano e lampeggiano per segnalare lo stato della stampante.

 o  o Indicatore illuminato nel colore mostrato

 o  o Indicatore lampeggiante nel colore mostrato

L'indicatore può essere spento, acceso o lampeggiante in qualsiasi colore

L'indicatore è spento

LED di stato LED Editor Lite Condizione

L'alimentazione è DISATTIVATA

Modalità di standby

Modalità di inizializzazione

Modalità di avanzamento carta

Modalità di stampa

Modalità di taglio

Modalità P-touch Editor Lite

Ricezione dati

Eliminazione del lavoro di stampa

Il coperchio del vano del rotolo DK è aperto. Chiudere 
correttamente il coperchio del vano del rotolo DK.

Le impostazioni della stampante vengono ripristinate.

Per ulteriori informazioni, vedere Ripristino di tutte le impostazioni 
ai valori predefiniti di fabbrica mediante i pulsanti della 
stampante di etichette a pagina 107.

Modalità sistema OFF

Se la luce arancione lampeggia a intervalli di 0,5 secondi, 
la stampante si trova in modalità raffreddamento.

Modalità di sovrascrittura dei dati

La stampante è in modalità di avvio

Contattare il Servizio clienti Brother.
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1 Velocemente significa a intervalli di 0,3 secondi.

(Una volta per 
2 secondi)

Errore fine rotolo

Errore di supporto esaurito

Errore di supporto errato

Errore di avanzamento carta

Errore di apertura del coperchio

Errore dati trasferiti

Errore di memoria piena

(Due volte per 
2 secondi)

Errore taglierina

Errore di tensione eccessiva dell'alimentazione dell'host USB

Errore di connessione del dispositivo non supportato dell'host USB

(Tre volte per 
2,5 secondi)

Errore di collegamento dell'hub dell'host USB

(lampeggia 
velocemente 1)

Errore di sistema

Quando si preme un pulsante diverso dal pulsante di 

alimentazione ( ), la sequenza del lampeggio cambia a seconda 
della causa dell'errore. Contattare il Servizio clienti Brother.

LED di stato LED Editor Lite Condizione
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Problemi di stampa 16

Problema Soluzione

Il LED di stato non si accende. Il cavo di alimentazione CA è inserito correttamente? 
Controllare che il cavo di alimentazione CA sia inserito. Se il cavo è inserito 
correttamente, provare a collegarlo a un'altra presa elettrica.

La stampante non stampa, oppure 
si verifica un errore di stampa.

• Il cavo si è allentato?
Controllare che il cavo sia collegato correttamente.

• Il rotolo DK è installato correttamente?
In caso negativo, rimuovere il rotolo DK e reinstallarlo.

• È rimasta una quantità di rotolo sufficiente?
Controllare che sia rimasta una quantità di rotolo sufficiente.

• Il coperchio del vano del rotolo DK è aperto?
Controllare che il coperchio del vano del rotolo DK sia chiuso.

• Si è verificato un errore di stampa o trasmissione?
Spegnere e riaccendere la stampante. Se il problema persiste, contattare 
il Servizio clienti Brother.

• Se la stampante è collegata tramite un hub USB, provare a collegarla 
direttamente al computer. In caso contrario, provare a collegarla a un'altra 
porta USB.

L'etichetta stampata contiene strisce 
o caratteri di bassa qualità oppure 
l'avanzamento dell'etichetta è errato.

La testina di stampa o il rullo sono sporchi?
Anche se generalmente la testina di stampa resta pulita durante l'uso normale, 
è possibile che della lanugine o della sporcizia provenienti dal rullo rimangano 
attaccati alla testina di stampa.
In tal caso, pulire il rullo.
Per ulteriori informazioni, vedere Pulizia del rullo a pagina 109.

Nel computer viene visualizzato 
un messaggio di errore 
di trasmissione dei dati.

La stampante è in modalità raffreddamento (il LED di stato lampeggia 
in arancione)?
Attendere che il LED di stato smetta di lampeggiare, quindi provare 
nuovamente a stampare.

Le etichette sono inceppate nella 
taglierina.

Contattare il Servizio clienti Brother.

L'etichetta non viene espulsa 
correttamente dopo la stampa.

• Verificare che la fessura di uscita delle etichette non sia bloccata.

• Controllare che il rotolo DK sia impostato correttamente: per farlo, 
rimuovere il rotolo DK e reinstallarlo.

• Verificare che il coperchio del vano del rotolo DK sia chiuso correttamente.

Si desidera annullare il lavoro 
di stampa corrente.

Assicurarsi che la stampante sia accesa e premere una volta il pulsante 

alimentazione ( ).

La qualità di stampa è bassa. Nel rullo è presente sporcizia o lanugine, che ne impediscono il libero 
movimento? 
Per ulteriori informazioni, vedere Pulizia del rullo a pagina 109.

Dopo aver sostituito il rotolo mentre 
il componente aggiuntivo era 
attivato, lo stile del layout non è stato 
aggiornato.

Chiudere P-touch Editor per uscire dal componente aggiuntivo, quindi 
riattivarlo.
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L'icona del componente aggiuntivo 
P-touch non è visualizzata 
in Microsoft Word.

• Microsoft Word è stato avviato da Microsoft Outlook?

• Microsoftt Word è stato scelto come editor predefinito per 
Microsoft Outlook?
A causa delle limitazioni del programma, il componente aggiuntivo 
Microsoft Word non funziona con le impostazioni di cui sopra. Chiudere 
Microsoft Outlook e riavviare Microsoft Word.

Dati ricevuti nel buffer. I dati di stampa sono salvati nel buffer. Se la stampante non ha ricevuto i dati 
completi, la stampa non inizia.

Spegnere e riaccendere la stampante.

La stampante è in modalità 
raffreddamento.

La temperatura della testina di stampa termica è troppo elevata.

La stampante interrompe la stampa e la riprende solo dopo che la testina 
termica si è raffreddata. La testina si surriscalda se si stampa un numero 
elevato di etichette.

Se la testina termica si surriscalda, potrebbe generare immagini al di fuori 
dell'area di stampa. Per evitare o tardare il surriscaldamento, accertarsi che 
la stampante sia soggetta ad adeguata ventilazione e non sia posizionata 
in uno spazio ristretto.

Se la stampante si deve raffreddare perché si è surriscaldata a causa del tipo 
di rotolo DK in uso o del contenuto dell'etichetta, la stampa potrebbe durare 
più del previsto.

Nota
Questa condizione può presentarsi più frequentemente quando si utilizza 
la stampante ad altitudini elevate (oltre i 3048 metri), in quanto il 
raffreddamento della stampante avviene in presenza di aria di minore 
densità.

Errori del rotolo DK. Controllare quanto segue:

• Si sta utilizzando il rotolo DK corretto.

• Il numero di etichette rimanente è sufficiente.

• Il rotolo DK è installato correttamente.

Errore taglierina. Se si verifica un errore della taglierina, tenere chiuso il coperchio del vano 
del rotolo DK e premere il pulsante di alimentazione ( ). La taglierina torna 
nella posizione normale e la stampante si spegne automaticamente.
Dopo lo spegnimento della stampante, controllare la fessura di uscita 
delle etichette e rimuovere eventuali etichette incastrate. Contattare il 
Servizio clienti Brother.

Impossibile rimuovere un errore. Per rimuovere un errore:

1 Aprire il coperchio del vano del rotolo DK, quindi richiuderlo.

2 Se l'errore non viene rimosso, premere il pulsante taglierina ( ).

3 Se l'errore non viene rimosso, spegnere e accendere nuovamente 
la stampante.

4 Se l'errore non è ancora stato rimosso, contattare il Servizio clienti Brother.

Problema Soluzione
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Si desidera reimpostare la 
stampante.

È possibile reimpostare la stampante utilizzando lo Strumento di impostazione 
della stampante tramite un computer.

Per ulteriori informazioni, vedere Modifica delle impostazioni della stampante 
di etichette a pagina 19.

È possibile reimpostare la stampante utilizzando i pulsanti sulla stampante.

Per ulteriori informazioni, vedere Ripristino di tutte le impostazioni ai valori 
predefiniti di fabbrica mediante i pulsanti della stampante di etichette 
a pagina 107.

Una volta usciti da P-touch Editor 
Lite, come si riavvia il programma 
mentre la stampante è ancora 
accesa?

Per riavviare l'applicazione esistono tre modi.

• Spegnere e riaccendere la stampante.

• Scollegare e ricollegare il cavo USB mentre la stampante è accesa.

• Avviare P-touch Editor Lite da Risorse del computer.

Problema Soluzione
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Quando si stampa tramite il cavo 
USB, la stampante effettua pause 
continue, poi riprende a stampare.

La stampante è impostata per la stampa sequenziale?

In tal caso, impostare la modalità di stampa con buffering.

Per Windows 7:

Aprire le proprietà della stampante facendo clic sul pulsante Start > 
Dispositivi e stampanti, facendo quindi clic con il pulsante destro del 
mouse sulla stampante da impostare e facendo quindi clic su Preferenze 
stampa. 

Fare clic sulla scheda Altro e selezionare l'opzione Inizia stampa 
al termine dello spooling dell'ultima pagina.

Per Windows 8 / Windows 8.1:

Aprire le proprietà della stampante facendo clic su Pannello di controllo 
nella schermata App > Hardware e suoni > Dispositivi e stampanti, 
facendo clic con il pulsante destro del mouse sulla stampante da impostare 
e facendo quindi clic su Preferenze stampa.

Fare clic sulla scheda Altro e selezionare l'opzione Inizia stampa 
al termine dello spooling dell'ultima pagina.

Per Windows 10:

Aprire le proprietà della stampante facendo clic sul pulsante Start > 
Impostazioni > Dispositivi > Stampanti e scanner > Dispositivi 
e stampanti, facendo quindi clic con il pulsante destro del mouse sulla 
stampante da impostare e facendo quindi clic su Preferenze stampa.

Fare clic sulla scheda Altro e selezionare l'opzione Inizia stampa 
al termine dello spooling dell'ultima pagina.

Per Windows

Problema Soluzione
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La lettura dei codici a barre stampati 
risulta impossibile.

 Stampare le etichette in modo tale che i codici a barre siano allineati con 
la testina di stampa, come illustrato qui di seguito:

1 Testina di stampa

2 Codici a barre

3 Orientamento di stampa

 Se le loro dimensioni vengono ridotte o ingrandite, i codici a barre 
potrebbero non essere leggibili.

 Provare a usare un altro scanner.

 Consigliamo di stampare il codice a barre con le opzioni della qualità 
di stampa impostate su Assegna priorità alla qualità di stampa. 

Per Windows 7:

Per visualizzare le opzioni di Qualità, aprire le proprietà della stampante 
facendo clic sul pulsante Start > Dispositivi e stampanti, facendo quindi clic 
con il pulsante destro del mouse sulla stampante da impostare e facendo 
quindi clic su Preferenze stampa.

Per Windows 8 / Windows 8.1:

Per visualizzare le opzioni di Qualità, aprire le proprietà della stampante 
facendo clic su Pannello di controllo nella schermata App > Hardware 
e suoni > Dispositivi e stampanti, facendo clic con il pulsante destro del 
mouse sulla stampante da impostare e facendo quindi clic su Preferenze 
stampa.

Per Windows 10:

Per visualizzare le opzioni di Qualità, aprire le proprietà della stampante 
facendo clic sul pulsante Start > Impostazioni > Dispositivi > Stampanti 
e scanner > Dispositivi e stampanti, facendo quindi clic con il pulsante 
destro del mouse sulla stampante da impostare e facendo quindi clic 
su Preferenze stampa.

Per Mac:

Per cambiare le opzioni relative alla qualità di stampa, aprire la finestra 
di dialogo Stampa e nel menu pop-up con le opzioni di stampa, selezionare 
Basilare. 

Problema Soluzione

1

2

3
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Informazioni sulla versione 16

I codici a barre stampati utilizzando 
applicazioni diverse da P-touch 
Editor non possono essere letti.

Se i dati del codice a barre sono stati creati utilizzando l'orientamento 
orizzontale, cambiare le impostazioni di Orientamento nella scheda Base del 
driver della stampante su Orizzontale e riprovare.

Problema Soluzione

Non si conosce il numero di versione 
del firmware per la stampante.

Per verificare il firmware più recente:

1 Accendere la stampante.

2 Premere e tenere premuto il pulsante taglierina ( ) per diversi secondi 
per stampare il rapporto.

È consigliabile usare un rotolo DK da 62 mm o più grande.

Si desidera verificare se si sta 
usando la versione più recente 
del software.

Usare P-touch Update Software per verificare di disporre della versione 
più recente.

Per ulteriori informazioni su P-touch Update Software, vedere Come aggiornare 
P-touch Software a pagina 100.

Problema Soluzione
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Specifiche della stampante di etichette 17

Specifiche del prodotto 17

Dimensioni
Dimensioni Circa 170 (L) × 222 (P) × 151 (A) mm

Peso Circa 1715 g (senza rotoli DK)

Indicatori LED
LED di stato (verde, arancione, rosso), LED Editor Lite (verde)

Pulsanti
Pulsante di accensione, pulsante di avanzamento carta, pulsante taglierina, pulsante Editor Lite

Stampa
Metodo Stampa termica diretta tramite testina termica

Testina di stampa 300 dpi / 1296 punti

Risoluzione di stampa 300 × 300 dpi

Velocità di stampa Massimo 110 mm/s

La velocità di stampa effettiva varia a seconda delle condizioni.

Funzionalità di stampa 
massima (larghezza)

101,6 mm

A seconda del tipo di ambiente, potrebbe non essere possibile stampare a larghezza 
standard. Per ulteriori informazioni, vedere il sito web support.brother.com 

Nota: se vengono impostati dei margini insufficienti, i lati delle etichette potrebbero 
venire troncati.

Interfaccia
USB Versione 2.0 velocità massima (periferica)

Host USB Classe HID

Alimentazione
Alimentazione 220 V-240 V CA 50/60 Hz 1,2 A

Spegnimento automatico Nessuna/1/2/4/8/12 ore

(Per modificare le impostazioni di Spegnimento automatico, vedere Modifica delle 
impostazioni della stampante di etichette a pagina 19.)

Altro
Taglierina Taglierina automatica a lunga durata 

Ambiente Temperatura/umidità 
di funzionamento

Tra 10 e 35 °C / tra 20 e 80% 
(Temperatura massima a bulbo bagnato: 27 °C)

Temperatura/umidità 
di funzionamento

Tra -20 e 60 °C / tra 5 e 95% 
(Temperatura massima a bulbo bagnato: 45 °C)

Sistemi operativi compatibili
Vedere support.brother.com per un elenco completo e aggiornato del software.

http://support.brother.com/
http://support.brother.com/
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È disponibile un kit di sviluppo del software (SDK, Software Development Kit). Visitare il Brother Developer 
Center (brother.com/product/dev).

Il b-PAC SDK e gli SDK per dispositivi mobili (solo Android) possono anche essere scaricati. (Gli SDK disponibili 
sono soggetti a modifica senza preavviso.)

Kit di sviluppo del software 18

http://brother.com/product/dev
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Poiché alcune funzioni di P-touch Editor non sono disponibili sulla stampante di etichette, quando si usa 
P-touch Editor per creare modelli, tenere presente quanto segue.

È possibile controllare un'anteprima del modello stampato prima che il modello creato venga trasferito alla 
stampante. Per ulteriori informazioni, vedere Trasferimento del modello a P-touch Transfer Manager a pagina 75.

Note sulla creazione di modelli 19

 Una parte del testo del modello che viene trasferita alla stampante verrà stampata usando dimensioni 
di font e carattere simili caricate nella stampante. Di conseguenza, l'etichetta stampata potrebbe differire 
dall'immagine del modello creato in P-touch Editor.

 A seconda dell'impostazione dell'oggetto testo, le dimensioni dei caratteri potrebbero venire ridotte 
automaticamente oppure una parte del testo potrebbe non venire stampata. In tal caso, modificare 
l'impostazione dell'oggetto testo.

 Anche se con P-touch Editor gli stili dei caratteri possono essere applicati a singoli caratteri, essi possono 
essere applicati a un blocco di testo solo tramite la stampante. Inoltre, alcuni stili di caratteri non sono 
disponibili sulla stampante.

 Gli sfondi specificati con P-touch Editor non sono compatibili con la stampante.

 Un layout P-touch Editor che utilizza la funzione di stampa divisa (ingrandendo l'etichetta e stampandola 
su due o più etichette) non può essere trasferito.

 Viene stampata solo la porzione di etichetta all'interno dell'area stampabile.

 I campi che superano l'area di stampa potrebbero non venire stampati completamente.

Note sul trasferimento di modelli 19

 L'etichetta stampata potrebbe differire dall'immagine visualizzata nell'area di anteprima di P-touch 
Transfer Manager.

 Se un codice a barre non caricato nella stampante viene trasferito alla stampante, se si tratta di un codice 
a barre bidimensionale, viene convertito in immagine. L'immagine del codice a barre convertito non può 
essere modificata.

 Tutti gli oggetti trasferiti che non possono essere modificati dalla stampante vengono convertiti in immagini.

 Gli oggetti raggruppati saranno convertiti in una singola bitmap.

Note sul trasferimento dei dati diversi dai modelli 19

 Se il numero o l'ordine dei campi in un database viene modificato e solo il database (file .csv) viene 
trasferito per aggiornarlo, il database potrebbe non collegarsi correttamente con il modello. Inoltre, 
la prima riga di dati del file trasferito deve essere riconosciuta dalla stampante come "nomi di campo".

 I loghi, i simboli e la grafica scaricati sulla stampante verranno scalati automaticamente al font residente 
o a uno qualsiasi dei simboli residenti nella libreria.

Note sull'uso di P-touch Transfer Manager19
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Procedura generale per la funzione P-touch Template 20

La procedura generale per l'uso della funzione P-touch Template è descritta qui di seguito.

Per ulteriori informazioni su come specificare le varie impostazioni, vedere Stampa di etichette usando 
P-touch Template a pagina 35.

Prima di collegare uno scanner di codici a barre a questa stampante di etichette, assicurarsi che 
le impostazioni nello scanner di codici a barre corrispondano alle impostazioni nello strumento Impostazioni 
P-touch Template specificato durante la preparazione. Per ulteriori informazioni, vedere Preparazione 
a pagina 36.

a Utilizzare P-touch Editor per creare un modello e trasferirlo quindi alla stampante.

b Collegare lo scanner di codici a barre alla stampante.

c Per specificare delle nuove impostazioni o eliminare le impostazioni precedenti, eseguire la scansione 
del codice a barre Comando P-touch Template.

d Eseguire la scansione del codice a barre Impostazioni di base per specificare l'impostazione desiderata.

e Specificare le impostazioni appropriate (A, B o C).

A. Stampa di modelli standard 20

1 Eseguire la scansione del codice a barre Numero modello predefinito.

B. Stampa di modelli avanzati 20

1 Eseguire la scansione del codice a barre Seleziona modello, quindi i codici a barre in Per l'immissione 
dei numeri.

2 Eseguire la scansione del codice a barre di cui si desidera utilizzare o copiare i dati.

3 Eseguire la scansione del codice a barre Inizia a stampare.

C. Stampa della ricerca nel database 20

1 Eseguire la scansione del codice a barre Seleziona modello, quindi i codici a barre in Per l'immissione 
dei numeri.

2 Eseguire la scansione del codice a barre delle chiavi per i dati del database.

3 Eseguire la scansione del codice a barre Delimitatore.

4 Eseguire la scansione del codice a barre Inizia a stampare.

f L'etichetta specificata viene stampata.

Elenco dei codici a barre per la funzione 
P-touch Template 20
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Elenco dei codici a barre per specificare le impostazioni 20

Per ulteriori informazioni su come specificare le impostazioni della stampante, vedere Stampa di etichette 
usando P-touch Template a pagina 35.

Nota
• Quando si utilizzano i codici a barre di questo elenco, nello strumento Impostazioni P-touch Template 

impostare le opzioni Trigger for P-touch Template Printing (Attiva stampa P-touch Template) 
e Command Prefix Character (Carattere prefisso comando) per i valori predefiniti di fabbrica.

• Verificare che i codici a barre vengano stampati ad alta risoluzione in modo che lo scanner di codici a barre 
possa leggerli correttamente per stampare le etichette desiderate.

 Comando P-touch Template (inizializzare + iniziare a specificare le impostazioni)

 Impostazioni di base

Taglio automatico attivato 
(taglio dopo ogni etichetta) + 

Taglia alla fine attivato 20

Taglio automatico attivato 
(taglio dopo ogni due etichette) + 

Taglia alla fine attivato 20

Taglio automatico disattivato + 
Taglia alla fine attivato 20

Taglio automatico disattivato + 
Taglia alla fine disattivato 20

Consente di assegnare la priorità alla 
qualità di stampa 20

Dai la priorità alla qualità di stampa
 20

Numero di copie 20



Elenco dei codici a barre per la funzione P-touch Template 

124

20

 Per l'immissione dei numeri 1

1 Consentono di specificare il numero di copie stampate e quando selezionare un modello.
Eseguire la scansione dei codici a barre per specificare un numero di tre cifre, come [0][0][7] o [0][1][5]. L'impostazione viene automaticamente 
applicata quando sono state specificate tre cifre.
Per modificare le impostazioni, eseguire di nuovo la scansione del codice a barre "Numero di copie" quando si cambia il numero di copie, oppure 
eseguire di nuovo la scansione del codice a barre "Seleziona modello" quando si cambia il numero di modello, quindi eseguire la scansione dei 
codici a barre per il nuovo numero a tre cifre.

1 20 2 20

3 20 4 20

5 20 6 20

7 20 8 20

9 20 0 20

00 20
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 Numero modello predefinito

Modello predefinito 1 20 Modello predefinito 2 20

Modello predefinito 3 20 Modello predefinito 4 20

Modello predefinito 5 20 Modello predefinito 6 20

Modello predefinito 7 20 Modello predefinito 8 20

Modello predefinito 9 20 Modello predefinito 10 20

 Seleziona modello  Serializzato

 Delimitatore  Inizializza

 Inizia a stampare

^NN

^ID
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